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1 About This Document

This document introduces the Remote Integrated Development Environment (RIDE). It
describes the installation process and the RIDE's user interface (windows, menus,
customisation options, keycode/keystrokemappings, etc.).

RIDE can be extensively customised; this document assumes that the default
configuration is in use.

1.1 Audience
It is assumed that the reader has a working knowledge of Dyalog.

For information on the resources available to help develop your Dyalog knowledge, see
https://www.dyalog.com/introduction.htm. New users might also find that it is helpful to
select the Show tips for glyphs check box in the General tab of the Preferences dialog
box, as detailed in Section 9.2.1).

1.2 Conventions
Unless explicitly stated otherwise, all examples in Dyalog documentation assume that ⎕IO
and ⎕ML are both 1.

Various icons are used in this document to emphasise specific material.

General note icons, and the type ofmaterial that they are used to emphasise, include:

Hints, tips, best practice and recommendations from Dyalog Ltd.

Information note highlighting material of particular significance or relevance.

Legacy information pertaining to behaviour in earlier releases of Dyalog or to
functionality that still exists but has been superseded and is no longer
recommended.
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Warnings about actions that can impact the behaviour of Dyalog or have
unforeseen consequences.

Although the Dyalog programming language is identical on all platforms, differences do
exist in the way some functionality is implemented and in the tools and interfaces that are
available. A full list of the platforms on which Dyalog version 18.0 is supported is available
at https://www.dyalog.com/dyalog/current-platforms.htm. Within this document,
differences in behaviour between operating systems are identified with the following
icons (representing macOS, Linux, UNIX and Microsoft Windows respectively):
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2 Introduction

The use of the RIDE is subject to the conditions of theMIT licence (see
https://github.com/Dyalog/ride/blob/master/licence). The installation and use of
the RIDE does not convey any additional rights to use Dyalog or any other Dyalog
products. Specifically, although the interpreter can be configured to allow the RIDE
to debug runtime executables, you should only do this if your Dyalog licence also
allows it.

The Remote Integrated Development Environment (RIDE) is a cross-platform, graphical
development environment capable of producing a rich user experience on a variety of
platforms. It supports the interactive use of APL notation to explore data, discover
algorithms and create solutions – or diagnose problems, resolve issues and resume the
execution of running applications.

The RIDE runs separately from the APL interpreter, and communicates with it using
TCP/IP sockets. The RIDE can be run on macOS, Microsoft Windows and Linux (including
the Raspberry Pi). In addition to being used as a front end for APL running locally, it can
also be used to launch APL sessions on remotemachines or to connect to APL
interpreters that are already running – either locally or remotely.

From Dyalog version 17.0, the interpreter can easily be configured to act as a web server
which provides the RIDE application as a web page. This makes it possible to run the RIDE
in a browser on any platform, without installing it locally. The RIDE needs to be installed
on themachine where the interpreter is running, so the files can be provided as a
webpage. Because no client-side installation is necessary, this mode is known as Zero
Footprint.

The RIDE has two main modes of use:
l Providing a user interface to an interpreter engine (local or remote).

The RIDE is the recommended IDE for Dyalog on macOS or Linux (including the
Raspberry Pi). In these environments, an application icon is provided to launch
RIDE and an APL interpreter together. In this mode, the RIDE and the interpreter
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can be thought of as a single unit. Under Microsoft Windows, the native Dyalog IDE
continues to provide the richest environment for the development of APL
applications for Microsoft Windows users.

l As a tool for managing connections to a collection of interpreter sessions.

In this mode, the RIDE-Dyalog Session dialog box is used to launch or connect to
one or more interpreters.

Although the RIDE can managemultiple concurrent Dyalog Sessions, each
Dyalog Session can only be connected to a single instance of the RIDE at any
one time.
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3 Installation

This chapter describes how to install the RIDE.

3.1 Pre-requisites
RIDE 4.3 can only connect to a Dyalog interpreter that is version 15.0 or later.

The RIDE is supported on the following operating systems:
l Linux x86_64 – the following distributions:

o Debian 8 onwards
o Fedora 25 onwards
o Ubuntu 14.04 onwards

distributions built on top of these should also work
(Linux distribution must also have libnss version 3.26 onwards)

l macOS – Yosemite onwards
l Microsoft Windows –Windows 7 onwards

For the zero-footprint RIDE:
l a compatible browser must be installed.
l the operating system must be supported by the underlying technology (see

https://github.com/electron/electron/blob/v6.1.10/docs/tutorial/support.md).

If Dyalog is not installed on themachine that the RIDE is being installed on, then the
APL385 font and keyboard mappings installed with the RIDEmean that they are available
when running a Dyalog Session through the RIDE. However, to be able to enter APL
glyphs outside a Dyalog Session (for example, in text files or emails) you will need to
download and install the appropriate files (files and instructions are available from
http://www.dyalog.com/apl-font-keyboard.htm, as is the Dyalog Unicode IME for
Microsoft Windows).
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3.2 Installing the RIDE
Installation instructions are dependent on operating system.

3.2.1 Zero Footprint

The use of the RIDE from a browser requires no installation on themachine where the
RIDE will run. However, the RIDEmust be installed on themachine where APL is installed,
so that Dyalog can act as a web server, making the necessary files available to the
browser.

When installing the RIDE, if you select the default location suggested by the
installer then APL can be launched as a RIDE server without creating a configuration
file (see Appendix B).

On non-Windows platforms, the Zero Footprint RIDE is automatically installed to the
default location ([DYALOG]/RIDEapp) when Dyalog is installed and no additional
installation is necessary to use the Zero Footprint RIDE from a browser – see Section 4.2.

3.2.2 Installing on Linux

The installation process for the RIDE is the same irrespective of whether it is installed as a
stand-alone product or on a machine that already has Dyalog installed.

To install the RIDE

1. Download the RIDE's .deb or .rpm file (whichever is appropriate for your Linux
distribution) from my.dyalog.com. If your Linux distribution does not support
either .deb or .rpm files, then please contact support@dyalog.com.

2. From the command line, use standard installation commands to install the
package.

The RIDE is now installed and ready to use. The RIDE icon (shortcut) is added to the
desktop.

3.2.3 Installing on macOS

The RIDE is the default UI for Dyalog on macOS and is installed at the same time as Dyalog
(see theDyalog for macOS Installation and Configuration Guide); no further installation
is required.
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To install the RIDE as a separate, stand-alone, product

1. Download the RIDE's .pkg file from my.dyalog.com.
2. Double-click on the RIDE's .pkg file.

The RIDE Installerwindow is displayed.

3. Follow the instructions in the RIDE Installerwindow to successful completion of
the installation process.

The RIDE is now installed and ready to use. The RIDE icon is added to the
Applications directory (accessed by selecting Applications from theGomenu in
the Findermenu bar).

Starting the RIDE adds its icon to the dock. To keep the RIDE icon in the dock
permanently, right-click on the icon and select Options > Keep in Dock from the drop-
down list that appears.

3.2.4 Installing on Microsoft Windows

The installation process for the RIDE is the same irrespective of whether it is installed as a
stand-alone product or on a machine that already has Dyalog installed.

To install the RIDE

1. Download the RIDE's .zip file from my.dyalog.com.
2. Unzip the downloaded .zip file, placing the setup_ride.exe and setup_ride.msi files

in the same location as each other.
3. Double-click on the setup_ride.exe file.

The RIDE Installationwindow is displayed.

4. Follow the instructions in the RIDE Installationwindow to successful completion of
the installation process.

The RIDE is now installed and ready to use. The RIDE icon (shortcut) is added to the
desktop.
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3.3 Configuration (.ini) File
A .ini configuration file can be used to define settings for the RIDE_INIT configuration
parameter. By default, the interpreter will look for a ride.ini file in:

l the directory in which the default session and log files are stored, for example,
C:\Users\JohnDoe\AppData\Local\Programs\Dyalog\ (on Microsoft Windows)

l $HOME/.dyalog/ (on IBM AIX, macOS and Linux)

This file is not automatically created by Dyalog but can be created manually. Examples of
the fields that you might want to include within the .ini configuration file are included in
Appendix B.

A different name and location for the .ini configuration file can be specified by including a
second mode, CONFIG, in the RIDE_INIT parameter (see Section 8.2.2) and setting it so
that CONFIG=<filename>, where <filename> is the fully-qualified path to, and name
of, a .ini configuration file containing name-value pairs related to mode, certificate details,
and so on.

The .ini configuration file must be located on themachine on which the interpreter
is running (this is not necessarily the samemachine as the one on which the RIDE is
running).
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4 Starting a Dyalog Session

When running a Dyalog Session through the RIDE, that Session should only be
accessed through the RIDE. One exception to this rule is when developing or
running applications that are ⎕SM/⎕SR based; access to the ⎕SMwindow cannot be
made through the RIDE.

When running a Dyalog Session through the RIDE, the Session can be:
l local to themachine on which the RIDE is running.

This requires Dyalog to be installed on themachine on which the RIDE is running.

l remote from themachine on which the RIDE is running.

The RIDE can start a Session using an interpreter installed on a remotemachine
irrespective of whether Dyalog is installed on themachine on which the RIDE is
running. In this situation:

o The operating system on which the remote interpreter is running is
irrelevant – the instructions given in this chapter apply to the operating
system on which the RIDE is running (the two operating systems do not
have to be the same).

o The remotemachine does not need to have the RIDE installed but the
Dyalog Session must be RIDE-enabled (see Section 8.2.2).

Connections between the RIDE and Dyalog interpreters are initialised through the RIDE-
Dyalog Session dialog box. The exception to this is Zero Footprint use, which always
requires Dyalog to be started first with suitable configuration parameters, after which the
RIDE will appear when you direct a web browser at the APL interpreter. See Section 4.2 for
more information on Zero Footprint mode.

This chapter describes how to use the RIDE to run Dyalog Sessions, both local and
remote.
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4.1 The RIDE-Dyalog Session Dialog Box
When the RIDE is started, the RIDE-Dyalog Session dialog box is displayed. The
RIDE-Dyalog Session dialog box comprises four areas, as shown in Figure 4-1:

l themenu bar
l the list of configurations
l the basic information for the configuration selected in the configuration list
l the type-dependent information for the configuration selected in the configuration

list

Figure 4-1: Areas of the RIDE-Dyalog Session dialog box (Microsoft Windows)

4.1.1 Menu Bar
The RIDE's UI can vary slightly across different operating systems (and window
managers); in particular, RIDE-specific menu bars can be located either within the
development environment or in the global menu bar.

The options available under theDyalogmenu are detailed in Table 4-1.

Item Description

About Dyalog Displays the About dialog box, which provides details of the RIDE.

Preferences Opens the Preferences dialog box (see Section 9.2).

Quit Closes the RIDE-Dyalog Session dialog box.

Table 4-1: Dyalogmenu options
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The options available under the Editmenu are detailed in Table 4-2.

Item Description

Undo Reverses the previous action (where possible).

Redo Reverses the effect of the previous Undo.

Cut Deletes the selected text and places it on the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text contents of the clipboard into the current location.

Select All
Selects all the text in the field in which the cursor is positioned. If the
cursor is not within a field, then selects the text in all fields.

Table 4-2: Editmenu options

4.1.2 List of Configurations

The list of configurations lists the names of previously-saved configurations. By default, a
placeholder configuration called unnamed is present in the list of configurations with the
Type set to Connect.

Selecting a configuration from this list displays its basic information and type dependent
information.

At the bottom of the list of configurations is a bar containing four buttons, as shown in
Figure 4-2. The buttons available are detailed in Table 4-3.

Figure 4-2: The list of configurations' button bar

Button Name Description

New
Creates a new entry in the list of configurations. The default name for
a new configuration is unnamed.

Clone
Creates an exact copy of the configuration currently selected in the list
of configurations. Details can then be changed in the cloned
configuration without impacting the original.

Table 4-3: Buttons in the list of configurations' button bar
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Button Name Description

Delete
Prompts for confirmation before deleting the configuration currently
selected in the list of configurations.

Save Saves all items in the list of configurations.

Table 4-3: Buttons in the list of configurations' button bar (continued)

In addition to the buttons, the following actions can be performed when a configuration
is selected in the list of configurations:

l activate the configuration

Click CONNECT/START/LISTEN (as appropriate) in the basic information area to
start a Dyalog Session through the RIDE.

l amend the configuration

Change details in the basic or type-dependent information areas. Changes must be
saved to be retained between RIDE sessions.

A configuration can also be activated by clicking the button to the right of its name in
the list of configurations.

4.1.3 Types

The Type can be one of three options (selected from a drop-down list). The type that is
selected determines the content of the type-dependent area. The options are:

l Start – the RIDE initiates and connects with a new local or remote interpreter (see
Section 4.1.3.1)

l Connect – a specific (local or remote) Dyalog interpreter is sought by the RIDE for
connection (see Section 4.1.3.2)

l Listen – the RIDE waits for a local or remote interpreter to connect to it (see
Section 4.1.3.3)

4.1.3.1 Type: Start

Themost common use of the RIDE is where the RIDE launches an APL interpreter process
and connects to it. The RIDE allocates a random TCP port and instructs the launched
interpreter to connect to it immediately. The RIDE is also able to launch remote processes
on machines that support Secure Shell (SSH) logins, in which case the communication
between the RIDE and the interpreter is also encrypted.
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To start a Dyalog Session

1. Open the RIDE-Dyalog Session dialog box.
2. Select Start from the Type drop-down list.
3. Select a security protocol from the drop-down list.

The type-dependent information fields are displayed:
l If the security protocol is set to Local: then the RIDE can only initiate and

connect with a local interpreter:
o Interpreter: the interpreter to initiate an instance of, selected from a

drop-down list comprising all versions of Dyalog that are installed on
themachine that the RIDE is running on; versions that are installed
but not supported by the RIDE are listed but not enabled. If the path
and/or name of the interpreter have been amended from the default
installation values, then they might not appear in the drop-down list.
An interpreter in this situation can be chosen by selecting Other… in
the drop-down list and entering its full path in the path to executable
field. The value of the path to executable field is remembered across
invocations of the RIDE.

o Working directory: optionally, specify the fully-qualified path to, and
name of, a directory that overrides the interpreter's default working
directory.

o Arguments: optionally, specify additional arguments for the
interpreter (one argument per line).

o Environment variables: optionally, specify additional configuration
parameters for the interpreter. These should be specified as
<key>=<value> pairs, with one pair per line, no extra spaces and no
quoting or escaping of value.

l If the security protocol is set to SSH then the RIDE connects to a local or
remote interpreter using the secure shell network protocol:

The use of SSH is not applicable when the interpreter is running on
theMicrosoft Windows operating system.

o Host: the IP address/unique DNS name of themachine that the
interpreter will be running on.

o Port: the number of the port that the RIDE and the interpreter will
connect through. By default, this is port 4502.

o SSH Port: the number of the port to use for SSH. The default is 22.
o User: the user name on themachine that the interpreter is running

on.
o Key file: the fully-qualified filename of the SSH identity file.
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o Password/passphrase: either the password corresponding to the
specified User or, if an encrypted key file is being used for
authentication, the passphrase.

n If an encrypted Key File is specified, a passphrase is required
for authentication.

n If an unencrypted Key File is specified, a password/passphrase
is not required.

n If a Key File is not specified, then the password corresponding
to the specified User is required.

o Interpreter: the interpreter to initiate an instance of, selected from a
drop-down list comprising all versions of Dyalog installed on the
machine specified in the Host field (click the button to populate
this list). The path to the interpreter selected in the drop-down list is
displayed in the path to executable field. If the required interpreter is
not included in the drop-down list, select Other… in the drop-down
list and enter its fully-qualified path in the path to executable field.
The value of the path to executable field is remembered across
invocations of the RIDE.

o Arguments: optionally, specify additional arguments for the
interpreter (one argument per line).

o Environment variables: optionally, specify additional configuration
parameters for the interpreter. These should be specified as
<key>=<value> pairs, with one pair per line, no extra spaces and no
quoting or escaping of value.

4. Click START.

In the Dyalog Session, selecting New Session in the Filemenu (see Section 5.1.2.1)
launches another instance of the interpreter whose path is specified in the path to
executable field.

4.1.3.2 Type: Connect

The RIDE connects to a specific running (local or remote) Dyalog interpreter that is
listening for connections. This is typically used when the RIDE is monitoring processes
that have been started to provide some kind of service and to debug them if something
unexpected happens.

revision20200707_430 14

RIDE User Guide



You should only configure a Dyalog interpreter to listen for connections if either of
the following apply:

l you have a firewall that allows you specify which client machines will be able
to connect

l you use a configuration file (see Appendix B) to specify suitable security
filters to limit access to the interpreter.

Your application can use 3502⌶ to enable debugging when it is appropriate (see
Section 8.1.3).

To safely experiment with configuring APL to listen for connections, leave the
address field in the following examples empty, for example,
RIDE_INIT="SERVE::4502". If the address field is empty, then only local
connections are allowed. The * used below instructs the interpreter to listen on all
available network adapters.

To start a Dyalog Session

1. On themachine that the interpreter will run on, start a Dyalog Session, optionally
specifying an IP address/DNS name and port that it will listen for RIDE connections
on using the RIDE_INIT configuration parameter. If specified, this will override any
RIDE_INIT values defined in a configuration file (see Section 3.3).

For example, if the RIDE is on a different machine and will connect to a Dyalog
version 16.0 Unicode 64-bit interpreter through port 4502, then enter the following
in a command window/at the command prompt:

l on AIX:
$ RIDE_INIT="SERVE:*:4502"
/opt/mdyalog/16.0/64/unicode/p7/mapl

l on Linux:
$ RIDE_INIT="SERVE:*:4502" dyalog

l on macOS:
$ RIDE_INIT="SERVE:*:4502" /Dyalog/Dyalog-
16.0.app/Contents/Resources/Dyalog/mapl

l on Microsoft Windows:
> cd "C:\Program Files\Dyalog\Dyalog APL-64 16.0
Unicode"
> dyalog RIDE_INIT=SERVE:*:4502

Alternatively, create a shortcut with the appropriate settings:
i. Select the appropriate Dyalog installation and create a shortcut to it.
ii. Right-click on the shortcut icon and select Properties from the

context menu that is displayed.
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The Properties dialog box is displayed.

iii. In the Shortcut tab, go to the Target field and:
o place "marks around the path
o append RIDE_INIT=SERVE:*:4502

For example: "C:\Program Files\Dyalog\Dyalog APL-
64 16.0 Unicode\dyalog.exe" RIDE_
INIT=SERVE:*:4502

iv. Click OK.

Alternatively, start a Dyalog Session and enter:

3502⌶ 'SERVE:*:4502' ⍝ Set RIDE_INIT
3502⌶ 1 ⍝ enable RIDE

2. On themachine that the RIDE is running on:
i. Open the RIDE-Dyalog Session dialog box.
ii. Select Connect from the Type drop-down list.
iii. Select a security protocol from the drop-down list.

The type-dependent information fields are displayed.
l If the security protocol is set to TCP:

o Host: the IP address/unique DNS name of themachine that
the interpreter is running on.

o Port: the number of the port that the interpreter is listening
on. By default, the interpreter listens on port 4502.

l If the security protocol is set to SSH then the RIDE connects to a
remote interpreter using the secure shell network protocol:

The use of SSH is not applicable when the interpreter is
running on theMicrosoft Windows operating system.

o Host: the IP address/unique DNS name of themachine that
the interpreter is running on.

o Port: the number of the port that the interpreter is listening
on. By default, the interpreter listens on port 4502.

o SSH Port: the number of the port to use for SSH. The default is
22.

o User: the user name on themachine that the interpreter is
running on.

o Key file: the fully-qualified filename of the SSH identity file.
o Password/passphrase: either the password corresponding to

the specified User or, if an encrypted key file is being used for
authentication, the passphrase.
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n If an encrypted Key File is specified, a passphrase is
required for authentication.

n If an unencrypted Key File is specified, a
password/passphrase is not required.

n If a Key File is not specified, then the password
corresponding to the specified User is required.

l If the security protocol is set to TLS/SSL then secure connections are
enabled:

By default, the RIDE qualifies the server certificate using the
root authority certificates available in theMicrosoft Certificate
Store.

o Host: the IP address/unique DNS name of themachine that
the interpreter is running on.

o Port: the number of the port that the interpreter is listening
on. By default, the interpreter listens on port 4502.

o Three optional check boxes (and associated fields) are relevant
if you have not added your root certificate to theMicrosoft
Certificate Store or are not running on theMicrosoft Windows
operating system:

n Provide user certificate: if selected, populate the Cert
and Key fields with the fully-qualified paths to, and
names of, the PEM encoded certificate file and key file
respectively – the interpreter (RIDE server) uses this to
verify that the RIDE client is permitted to connect to it.

n Custom root certificates: if selected, populate the
Directory field with the fully-qualified path to, and name
of, the directory that contains multiple root certificates
and key files to use for authentication.

n Validate server subject common name matches
hostname: verifies that the CN (Common Name) field of
the server's certificatematches the hostname.

iv. Click CONNECT.

4.1.3.3 Type: Listen

The RIDE waits for a local or remote interpreter to connect to it. This approach is more
secure than configuring the interpreter to listen for connections, because an intruder will
only be able to communicate with the RIDE rather than an APL system. An application
that needs to be debugged can initiate the connection to a listening RIDE using 3502⌶ to
set RIDE_INIT when debugging is desired (see Section 8.1.3).
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To start a Dyalog Session

1. On themachine that the RIDE is running on:
i. Open the RIDE-Dyalog Session dialog box.
ii. Select Listen from the Type drop down list.

The type-dependent information fields are displayed.
l In theHost field, specify the IP address/unique DNS name that the

RIDE will bind to. By default, the RIDE will bind to all interfaces.
l In the Port field, specify the number of the port that the RIDE should

listen on. By default, the RIDE listens on port 4502.
iii. Click LISTEN.

TheWaiting for connection... dialog box is displayed.
2. On themachine that the interpreter will run on, start a Dyalog Session from the

command prompt. When doing this, the IP address/DNS name for themachine
that the RIDE is running on and the same port number as the RIDE is listening on
must be specified as connection properties.
For example, if the RIDE is running on a machine that has DNS name
jaypc.dyalog.bramley and is listening on port 4502, then enter the following in a
command window/at the command prompt:

l on AIX:
$ RIDE_INIT="CONNECT:jaypc.dyalog.bramley:4502"
/opt/mdyalog/16.0/64/unicode/p7/mapl

l on Linux:
$ RIDE_INIT="CONNECT:jaypc.dyalog.bramley:4502" dyalog

l on macOS:
$ RIDE_INIT="CONNECT:jaypc.dyalog.bramley:4502"
/Dyalog/Dyalog-16.0.app/Contents/Resources/Dyalog/mapl

l on Microsoft Windows:
> cd "C:\Program Files\Dyalog\Dyalog APL-64 16.0
Unicode"
> dyalog RIDE_INIT=CONNECT:jaypc.dyalog.bramley:4502

The Dyalog Session starts.

Alternatively, start a Dyalog Session and enter:

3502⌶'CONNECT:jaypc.dyalog.bramley:4502'
3502⌶1

The newDyalog Session will connect to the RIDE and remain connected until the Dyalog
Session is terminated.
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On Microsoft Windows, an alternative to using the command window is to create a
shortcut with the appropriate settings.

To configure the shortcut

1. Select the appropriate Dyalog installation and create a shortcut to it.
2. Right-click on the shortcut icon and select Properties from the context menu

that is displayed.

The Properties dialog box is displayed.

3. In the Shortcut tab, go to the Target field and:
i. place " marks around the path
ii. append RIDE_INIT=CONNECT:10.0.38.1:4502

For example: "C:\Program Files\Dyalog\Dyalog APL-64 16.0
Unicode\dyalog.exe" RIDE_INIT=CONNECT:10.0.38.1:4502

4. Click OK.

4.2 The Zero Footprint RIDE
The RIDE is an application that is implemented using a combination of HTML and
Javascript. A full RIDE installation includes a small web server framework called Node/JS,
which acts as a host for the application, and an embedded web browser that renders it to
the user as a desktop application.

Dyalog is able to act as a web server, hosting the RIDE application and making it available
to any compatible web browser – this is known as "Zero Footprint" operation as the RIDE
is not installed on the client machine but is downloaded by the web browser on demand.
The advantage of the Zero Footprint RIDE is that an APL session can bemonitored and
maintained from any device with a suitable browser installed; no installation of RIDE is
required.

The Zero Footprint RIDE provides the same features for viewing and developing APL code
as the desktop RIDE, with the following limitations:

l The Zero Footprint RIDE can only interact with the APL interpreter that it is
connected to; none of the functionality related to launching new sessions or
connecting to running APL sessions is available.

l Preferences are persisted in browser storage using cookies.
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l Behaviour that is provided by the browser (undo/redo, cut/copy/paste, change
font size) does not appear in the RIDE's menus.

l Window captions cannot be controlled.

To make the Zero Footprint RIDE available from a web browser

1. Install Dyalog and the RIDE. Thesemust both be installed on the samemachine;
the RIDEmust be installed in its default location. On non-Windows platforms the
Zero Footprint RIDE is automatically installed when Dyalog is installed. For
information on installing the RIDE on Microsoft Windows, see Section 3.2.4

2. Set the RIDE_INIT configuration parameter to HTTP:address:port (see
Section 8.2.2), for example, RIDE_INIT=HTTP:*:8080.

3. Start a Dyalog session.

The Zero Footprint RIDE can now be accessed from a web browser by navigating to
http://<address>:<port>, for example, http://10.0.38.1:8080.

On non-Windows platforms (IBM AIX, macOS and Linux), the interpreter expects to find
the Zero Footprint RIDE files in the [DYALOG]/RIDEapp directory; this removes the need
to include the HttpDir field in a configuration file (if one is used – see Section 3.3).
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5 The Dyalog Development
Environment

When a Dyalog Session is started through the RIDE, the Dyalog development
environment is displayed. This means that:

l the Dyalog Session user interface is displayed (see Section 5.1)
l the keyboard key mappings for APL glyphs are enabled (see Section 5.2)

5.1 Session User Interface
Themenu bar menu options on macOS are different to those on Microsoft
Windows and Linux. This section details the options for Microsoft Windows and
Linux; for themacOS options see theDyalog for macOS UI Guide.

The RIDE's UI can vary slightly across different operating systems (and window
managers); in particular, RIDE-specific menu bars can be located either within the
development environment or in the global menu bar.

By default, the Dyalog Session user interface includes five elements, as shown in
Figure 5-1:

l a caption (see Section 5.1.1)
l a menu bar (see Section 5.1.2)
l a Language bar (see Section 5.1.3)
l a Session window (see Section 5.1.4)
l a Status bar (see Section 5.1.5)

revision20200707_430 21

RIDE User Guide



Figure 5-1: The default Dyalog Session user interface (Microsoft Windows)

Additional elements can also be present, as shown in Figure 5-2:
l a workspace explorer (see Section 5.1.6)
l a debug information window (see Section 5.1.7)

Figure 5-2: The Dyalog Session user interface with workspace explorer and debug
information window displayed (Microsoft Windows)
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A context menu is available in the Sessionwindow, all Editwindows and the Tracewindow
(see Section 5.1.8).

5.1.1 Caption

The caption at the top of the Sessionwindow is the name of the workspace.

The caption can be customised (see Section 9.2.5).

5.1.2 Menu Bar
Themenu bar menu options on macOS are different to those on Microsoft
Windows and Linux. This section details the options for Microsoft Windows and
Linux; for themacOS options see theDyalog for macOS UI Guide.

Themenu bar menu options are:
l Filemenu (see Section 5.1.2.1)
l Editmenu (see Section 5.1.2.2)
l Viewmenu (see Section 5.1.2.3)
l Windowmenu (see Section 5.1.2.4)
l Actionmenu (see Section 5.1.2.5)
l Helpmenu (see Section 5.1.2.6)

Themenu names in themenu bar and the options under each menu can be customised
(see Section 9.2.6).

5.1.2.1 File Menu

The options available under the Filemenu are detailed in Table 5-1. These control the
RIDE-enabled APL process connections (both on local and remotemachines).

Item Description

Open...

Prompts for a filename. If a workspace file is selected (a .dws file)
then it is loaded into the Session; any other file is opened in the
Editwindow. Only relevant if the Session was started using the
Start connection type (see Section 4.1.3.1).

New Session
Starts a newDyalog Session (a new instance of the interpreter).
Only relevant if the Session was started using the Start
connection type (see Section 4.1.3.1).

Table 5-1: Filemenu options
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Item Description

Connect… Opens the RIDE-Dyalog Session dialog box (see Section 4.1).

Quit Terminates the Dyalog Session (see Section 7.9).

Table 5-1: File menu options (continued)

5.1.2.2 Edit Menu

The options available under the Editmenu are detailed in Table 5-2. These assist with
manipulating text within (and between) windows.

Item Description

Undo Reverses the previous action.

Redo Reverses the effect of the previous Undo.

Cut
Deletes the selected text from the active window and places it on
the clipboard.

Copy Copies the selected text to the clipboard.

Paste
Pastes the text contents of the clipboard into the active window
at the current location.

Preferences Opens the Preferences dialog box (see Section 9.2).

Table 5-2: Editmenu options

A context menu that includes theUndo, Redo, Cut, Copy and Paste options from the Edit
menu is available in the Sessionwindow, all Editwindows and the Tracewindow – see
Section 5.1.8.

5.1.2.3 View Menu

The options available under the Viewmenu are detailed in Table 5-3. These enable the
appearance of the Dyalog Session to be changed.
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Item Description

Show Language Bar
Toggles display of the Language bar (see Section 5.1.3) at the top
of the Sessionwindow.

Show Status bar
Toggles display of the Status bar (see Section 5.1.5) at the bottom
of the Sessionwindow.

ShowWorkspace
Explorer

Toggles display of the workspace explorer (see Section 5.1.6) to
the left of the Sessionwindow.

ShowDebug
Toggles display of the debug information window (see
Section 5.1.7) to the right of the Sessionwindow.

LineWrapping in
Session

Toggles line wrapping. When off, ⎕PW is used to determine line
length. When on, a combination of ⎕PW and line wrapping is
used.

Stops

Toggles display of an additional column at the left-hand side of
the Edit/Tracewindows in which break-points can be set/unset.
Hiding this column does not remove any previously-set break-
points.

Line Numbers Toggles display of line numbers in the Edit/Tracewindows.

Outline

Toggles code folding/outlining for control structures (including
:Section structures) and functions in Editwindows. When
toggled, existing code in an open Editwindow is automatically
updated to reflect the new rules.

Increase Font Size Increases the size of the font in all the windows.

Decrease Font Size Decreases the size of the font in all the windows.

Reset Font Size Sets the size of the font in all the windows to its default value.

Toggle Full Screen
Toggles the entire session between its current size and full screen
size.

Table 5-3: Viewmenu options
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5.1.2.4 Window Menu

The option available under theWindowmenu is detailed in Table 5-4. This closes all open
Edit and Tracewindows.

Item Description

Close All Windows
Closes all open Edit and Tracewindows (the Sessionwindow,
workspace explorer and debug information window remain
open).

Table 5-4: Windowmenu options

5.1.2.5 Action Menu

The options available under the Actionmenu are detailed in Table 5-5. These enable Edit
and Tracewindows to be opened and allow currently-running APL code to be interrupted
with trappable events.

Item Description

Edit
If the cursor is on or immediately after <object name>, then
opens an Editwindow on that name.

Trace

In the Sessionwindow:
l If the cursor is on a line containing calls to multi-line

functions, a Tracewindow is opened and the functions
traced (explicit trace).

l If the cursor is on a line containing no text and there is a
suspended function (or operator) on the execution stack,
open a Tracewindow for that function (naked trace)

In a Tracewindow:
l Open a new Tracewindow for any multi-line function (or

operator) in that line and trace that line as it is evaluated.

Clear all
trace/stop/monitor

Removes any trace/stop/monitor flags (as set by
⎕TRACE/⎕STOP/⎕MONITOR) from all functions in the workspace.

Weak Interrupt Suspends execution at the start of the next line.

Strong Interrupt Suspends execution after the current primitive operation.

Table 5-5: Actionmenu options
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5.1.2.6 Help Menu

The options available under theHelpmenu are detailed in Table 5-6. These provide access
to the Dyalog documentation, website, forum and update portal.

Item Description

Dyalog Help
Opens your default web browser on the welcome page of
Dyalog's online documentation (http://help.dyalog.com).

Documentation
Centre

Opens your default web browser on the Documentation Centre
page of Dyalog Ltd's website
(http://www.dyalog.com/documentation.htm).

Dyalog Website
Opens your default web browser on the home page of Dyalog
Ltd's website (http://www.dyalog.com).

MyDyalog
Opens your default web browser on the login page for MyDyalog,
the customer portal for updates of Dyalog
(https://my.dyalog.com).

Dyalog Forum
Opens your default web browser on themain page of Dyalog
Ltd's forum (http://www.dyalog.com/forum).

About
Displays the About dialog box, which provides details of the
current RIDE and connected Dyalog interpreter.

Table 5-6: Helpmenu options

5.1.3 Language Bar

The Language bar is located at the top of the Sessionwindow, beneath themenu bar. It
contains buttons for each of the glyphs used as primitives in Dyalog.

When the cursor is positioned over one of the glyphs, information for that glyph is
displayed. This includes the name of the glyph, the keyboard shortcut to enter it, its
monadic/dyadic name and examples of its syntax, arguments and result.

Clicking on one of the glyphs copies that glyph into the active Session/Editwindow at the
position of the input cursor (the same as typing it directly into the Session/Editwindow).

The order of glyphs in the Language bar can be customised by using themouse to drag-
and-drop individual glyphs to the required location.
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Display of the Language bar can be toggled with the View > Show Language Barmenu
option or by entering the Toggle Language bar command (<LBR>).

On the right hand side of the Language bar is the button:
l Positioning the cursor over the button displays a dynamic tooltip showing all

configured keyboard shortcuts for command codes – for more information on
these, see Section 7.1.

l Clicking on the button displays the Preferences dialog box (the same as
selecting the Edit > Preferences menu option) – for more information on the
Preferences dialog box, see Section 9.2.

5.1.4 Session Window

The primary purpose of the Sessionwindow is to provide a scrolling area within which a
user can enter APL expressions and view results. See Section 6.1 for more information on
the Sessionwindow.

You can move, resize, maximise and minimise the Sessionwindow using the standard
facilities provided by your operating system.

5.1.5 Status Bar

The Status bar is located at the bottom of the Sessionwindow. It contains a button and
three Session status fields, as shown in Figure 5-3; the items in the Status bar are detailed
in Table 5-7.

Figure 5-3: The Status bar

Item Description

Opens the Preferences dialog box (see Section 9.2).

⎕SI:
<number> Displays the length of ⎕SI. Turns blue if non-zero.

&: <number>
Displays the number of threads currently running (minimum value is
1). Turns blue if greater than 1.

Ln <num>,
Col <num>

Displays the location of the cursor in the active window (line and
column numbers).

Table 5-7: Items in the Status bar
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5.1.6 Workspace Explorer

The workspace explorer is located to the left of the Sessionwindow. It contains a
hierarchical tree view of all the namespaces, classes, functions, operators and variables in
the active workspace (under #) and in the system namespace (under ⎕SE).

Double-clicking on a namespace, class, function, operator or variable opens its definition
in the Editwindow.

Display of the workspace explorer can be toggled with the View > Show Workspace
Explorermenu option or by entering the Toggle Workspace Explorer command (<WSE>).

5.1.7 Debug Information Window

The debug information window is located to the right of the Sessionwindow. It comprises
two areas:

l The Threads area lists the threads that are currently in existence. For each thread
the following information is provided:

o a description comprising the thread ID (⎕TID) and name (⎕TNAME)
o the state of the thread, that is, what it is doing (for example, Session,

Pending, :Hold, ⎕NA)
o the thread requirements (⎕TREQ)
o a flag indicating whether the thread is Normal or Paused

The toolbar displayed at the top of the Threads area is shown in Figure 5-4; the
icons on this toolbar are detailed in Table 5-8.

Figure 5-4: The Threads area's toolbar

Icon Action Description

Refresh now Refresh the list of threads.

Continue
execution of
this thread

Resume execution of the currently selected thread.

Table 5-8: Elements that can be contained within the element
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Icon Action Description

Continue
execution of all
threads

Resume execution of any paused threads. For
information on threads, see theDyalog Programming
Reference Guide.

Table 5-8: Elements that can be contained within the element (continued)

l The SI Stack area lists the functions in the execution stack; each function in the list
also has the line number and source code of the line that caused the function to be
added to the stack. Equivalent to the result of )SI.

Display of the debug information window can be toggled with the View > Show Debug
menu option.

5.1.8 Context Menu

A context menu is available by right-clicking within the Session, Edit and Tracewindows.
The options available under the context menu are dependent on the window from which
it was accessed and are detailed in Table 5-9.

Item Description

Fix Edit: Fixes the function without closing the Editwindow.

Skip to line
Trace: Moves the current execution marker to the line on which
the cursor is positioned.

Cut
Session/Edit/Trace: Deletes the selected text from the active
window and places it on the clipboard. Only enabled when text is
selected. Never enabled in the Tracewindow.

Copy
Session/Edit/Trace: Copies the selected text to the clipboard.
Only enabled when text is selected.

Paste
Session/Edit/Trace: Pastes the text contents of the clipboard into
the active window at the current location. Never enabled in the
Tracewindow.

Undo
Session/Edit/Trace: Reverses the previous action (where
possible). Never enabled in the Tracewindow.

Redo
Session/Edit/Trace: Reverses the effect of the previous Undo.
Never enabled in the Tracewindow.

Table 5-9: Context menu options
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5.2 Keyboard Key Mappings for APL Glyphs
A set of keyboard key mappings for APL glyphs is installed with the RIDE. When the RIDE is
the active application, these key mappings are automatically enabled. The RIDE attempts
to identify a user's locale and use the appropriate key mappings; if the locale cannot be
identified or the locale-specific key mappings have not been configured, then the default
configuration is used (key mappings for a US keyboard).

Using this set of key mappings, APL glyphs are entered by pressing the prefix key followed
by either the appropriate key or the SHIFT key with the appropriate key. The prefix key
and key mappings can be customised (see Section 9.2.2).

5.2.1 Other Keyboard Options

Installing and enabling a set of key mappings allows Dyalog glyphs to be entered in other
applications (for example, email). An alternative set of key mappings can also be used to
replace the default key mappings for the RIDE.

Information and the requisite downloadable files are available at
http://www.dyalog.com/apl-font-keyboard.htm.

If you have the Dyalog Unicode IME installed, then the RIDE activates it by default.
It can be disabled by unchecking the Also enable Dyalog IME checkbox in the
Keyboard tab of the Preferences dialog box (see Section 9.2.2).

If Dyalog is not installed on themachine that the RIDE is running on, then the
Dyalog Unicode IME can be downloaded and installed from
http://www.dyalog.com/apl-font-keyboard.htm.

Most Linux distributions released after mid-2012 support Dyalog glyphs by default.
For more information, see theDyalog for UNIX Installation and Configuration
Guide.
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6 Input Windows

Instead of just a single Sessionwindow, the Dyalog Development Environment can
comprisemultiple windows:

l Sessionwindow – created when a Dyalog Session is started through the RIDE and
always present while the Session is live. There is only one Sessionwindow. For
more information, see Section 6.1.

l Editwindows – created and destroyed dynamically as required. There can be
multiple Editwindows (one for each APL object). For more information, see
Section 6.2.

l Tracewindow – created and destroyed dynamically as required. There is only one
Tracewindow. For more information, see Section 6.3.

When multiple windows are open, the window that has the focus is referred to as the
active window.

6.1 Session Window
The Sessionwindow contains:

l the input line – the last line entered in the Sessionwindow; this is (usually) the line
into which you type an expression to be evaluated.

l the Session log – a history of previously-entered expressions and the results they
produced.

If a log file is being used, then the Session log is loaded into memory when a Dyalog
Session is started. When the Dyalog Session is closed, the Session log is written to the log
file, replacing its previous contents.

6.2 Edit Window
This section applies to the RIDE's built-in editor. A different editor can be specified
by setting the RIDE_EDITOR configuration parameter to the fully-qualified path of
the desired editor's executable file.

revision20200707_430 32

RIDE User Guide



The Editwindow is used to define new objects as well as view/amend existing objects.

An Editwindow can be opened from the Sessionwindow in any of the following ways:
l Enter )ED <object name>

l Enter ⎕ED '<object name>'

l Enter <object name> <ED>
(for an explanation of the <ED> syntax, see Section 7.1)

l Double-click on/after <object name>

If the object name does not already exist, then it is assumed to of function/operator type.
Different types can be explicitly specified using the )ED or ⎕ED options – see )ED or ⎕ED in
the Dyalog APL Language Reference Guide.

An Editwindow can be opened from the Tracewindow by entering the Edit command
(<ED>), double-clicking the cursor or clicking the button in the toolbar (see
Section 6.3.1). The position of the cursor when this is done determines the name of the
object that the Editwindow is for:

l If the cursor is on or immediately after <object name>, then the Editwindow
opens on that name.

l If the cursor is anywhere else, then the Editwindow opens for themost recently-
referenced function on the stack. This is a naked edit.

An Editwindow can be opened from another Editwindow in any of the following ways:
l Move the cursor over/after <object name> and enter the Edit command (<ED>)
l Double-click on/after <object name>

By default, the Editwindow is docked to the right of the SessionWindow.

6.2.1 Toolbar

The toolbar displayed at the top of the Editwindow is shown in Figure 6-1; the icons on
this toolbar are detailed in Table 6-1.

Figure 6-1: The EditWindow's toolbar
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Icon Action Description

Save changes
and return

Saves changes and closes the EditWindow.

Toggle line
numbers

Turns the display of line numbers on/off.

Comment
selected text

Add a comment symbol (⍝) to the beginning of the line in
which the cursor is positioned. If text has been selected, then
a comment symbol is added at the start of the line on which
the selection starts and at the start of each subsequent line of
text within the selection.
Same as the Comment Out command (<AO>).

Uncomment
selected text

Removes the comment symbol (⍝) at the beginning of the line
in which the cursor is positioned. If text has been selected,
then comment symbols are removed from the start of each
selected line of text. Comment symbols that are not at the
start of a line of text cannot be removed.
Same as theUncomment command (<DO>).

Search
Opens the Search bar, enabling a search to be performed – see
Section 6.2.2.

Table 6-1: Icons on the Editwindow's toolbar

6.2.2 Search and Replace

The icon in the Editwindow's toolbar opens the Search bar, enabling a search for
every occurrence of a specified string (this can include APL glyphs) to be performed within
the code in the Editwindow; optionally, a replacement string can be applied on an
individual basis.

The Search bar is shown in Figure 6-2; the icons in the Search bar are detailed in Table 6-2.

Figure 6-2: The Search bar (default)

The icon (Toggle replace mode) extends the Search bar to include a Replace field and
related icons, as shown in Figure 6-3 .
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Figure 6-3: The Search bar (extended to include display of the Replace fields)

Icon Action Description

Search for
previous match

Positions the cursor at the previous occurrence of the Search
text.

Search for next
match

Positions the cursor at the next occurrence of the Search text.

Find in selection Only searches within the selected text.

Close Closes the Search bar.

Replace
Replaces the selected text in the Editwindowwith the text
specified in the Replace field of the Search bar and highlights
the next match.

Replace all
Replaces all occurrences of the text specified in the Find field of
the Search bar with that specified in the Replace field of the
Search bar.

Table 6-2: Icons on the Search bar

The Find field includes three filters, as detailed in Table 6-3. Any combination of these
filters can be applied when performing a search.

Icon Action Description

Match case
Applies a case-sensitive filter so that only occurrences that
match the case of the string in the Find field are highlighted.

Match whole
word

Only highlights whole words that match the string in the Find
field.

Some glyphs are treated as punctuation when
identifying "whole words", for example, ; : , { } 
[ ] ( )

Table 6-3: Filters in the Find field
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Icon Action Description

Use regular
expression

Allows regular expressions to be specified in the Find field.

Table 6-3: Filters in the Find field (continued)

To search for a string

1. Enter the string to search for in the Find field in one of the following ways:
l Press the Search button and enter the string directly in the Find field.
l Enter the Search command (<SC>) and enter the string directly in the Find

field.
l Select the string in the Tracewindow and enter the Search command (<SC>)

or press the Search button ; the selected string is copied to the Find field.
All occurrences of the specified string are highlighted in the Editwindow and the
number of occurrences is displayed to the right of the Find field. If the content of
the Editwindow is sufficiently long for there to be a vertical scroll bar, then the
locations of occurrences of the specified string within the entire content are
identified by yellowmarks overlaid on the scroll bar.

2. Press the Enter key to select the first occurrence of the search string after the last
position of the cursor.

3. Press the Search for next match button to advance the selection to the next
occurrence of the search string.

4. Repeat step 3 as required (the search is cyclic).
5. Press the Esc key to exit the search functionality.

To replace a string

1. Do one of the following:
l Enter the string to search for in the Find field in one of the following ways:

o Press the Search button and enter the string directly in the Find
field.

o Enter the Search command (<SC>) and enter the string directly in the
Find field.

o Select the string in the Editwindow and enter the Search command
(<SC>) or press the Search button ; the selected string is copied to
the Find field.

Press to extend the Search bar to display the Replace field.
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l Enter the Replace command (<RP>) and enter the string directly in the Find
field.

l Select the string in the Editwindow and enter the Replace command (<RP>);
the selected string is copied to the Find field and the Replace field is
displayed.

2. Enter the replacement string directly in the Replace field.
3. Press the Enter key to select the first occurrence of the search string after the last

position of the cursor.
4. Do one of the following:

l Press the Enter key or the Replace button to replace the selected
occurrence of the search string and to advance the selection to the next
occurrence of the search string.

l Press the Search for next match button to leave the selected
occurrence of the search string unaltered and to advance the selection to
the next occurrence of the search string.

l Press the Replace all button to replaces all occurrences of the search
string.

5. Press the Close button to exit the search and replace functionality.

6.2.3 Exiting the Edit Window

To save changes and close the Editwindow:
l click in the Editwindow's tab and select yes when prompted whether to save

changes
l click in the Editwindow's toolbar
l use the Escape command (<EP>)

To close the Editwindowwithout saving changes:
l click in the Editwindow's tab and select nowhen prompted whether to save

changes
l use theQuit command (<QT>)

6.3 Trace Window
The Tracewindow aids debugging by enabling you to step through your code line by line,
display variables in Editwindows and watch them change as the execution progresses.
Alternatively, you can use the Sessionwindow and Editwindows to experiment with and
correct your code.
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A Tracewindow can be opened from the Sessionwindow by entering <expression>
<TC>. This is an explicit trace and lets you step through the execution of any non-primitive
functions/operators in the expression.

By default, Dyalog is also configured to initiate an automatic tracewhenever an error
occurs, that is, the Tracewindow opens and becomes the active window and the line that
caused the execution to suspend is selected. This is controlled by the interpreter
configuration parameter TRACE_ON_ERROR (for information on configuration
parameters, see theDyalog for <operating system> Installation and Configuration Guide
specific to the operating system that you are using).

By default, the Tracewindow is docked beneath the Session and Editwindows. Other
than setting/removing breakpoints (see Section 7.8.1), Tracewindows are read only.

6.3.1 Toolbar

The toolbar displayed at the top of the Editwindow is shown in Figure 6-4; the icons on
this toolbar are detailed in Table 6-4.

Figure 6-4: The EditWindow's toolbar

Icon Action Description

Quit this
function

Cuts the execution stack back one level.

Toggle line
numbers

Turns the display of line numbers on/off.

Execute line Executes the current line and advances to the next line.

Trace into
expression

Traces execution of the current line and advances to the next
line. If the current line calls a user-defined function then this is
also traced.

Table 6-4: Icons on the Tracewindow's toolbar
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Icon Action Description

Stop on next
line of calling
function

Continues execution of the code in the Tracewindow from the
current line to completion of the current function or operator.
If successful, the selection advances to the next line of the
calling function (if there is one).

Continue
execution of
this thread

Closes the Tracewindow and resumes execution of the current
application thread from the current line.

Continue
execution of all
threads

Closes the Tracewindow and resumes execution of all
suspended threads.

Interrupt Interrupts execution with a weak interrupt.

Edit name

Converts the Tracewindow into an Editwindow as long as the
cursor is on a blank line or in an empty space. However, if the
cursor is on or immediately after an object name that is not
the name of the suspended function, then an Editwindow for
that object name is opened.

Clear stops for
this object

Clears all breakpoints (resets ⎕STOP) on the function(s) in the
Edit/Tracewindows.

Search
Opens the Search bar, enabling a search to be performed – see
Section 6.3.1).

Table 6-4: Icons on the Trace window's toolbar (continued)

6.3.2 Search

The icon in the Tracewindow's toolbar opens the Search bar, enabling a search for
every occurrence of a specified string (this can include APL glyphs) to be performed within
the code in the Tracewindow.

The Search bar is shown in Figure 6-5; the icons in the Search bar are detailed in Table 6-5.

Figure 6-5: The Search Bar
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Icon Action Description

Search for
previous match

Positions the cursor at the previous occurrence of the Search
text.

Search for next
match

Positions the cursor at the next occurrence of the Search
text.

Find in selection Only searches within the selected text.

Close Closes the Search bar.

Table 6-5: Icons on the Search bar

To search for a string

1. Enter the string to search for in the Find field in one of the following ways:
l Press the Search button and enter the string directly in the Find field.
l Enter the Search command (<SC>) and enter the string directly in the Find

field.
l Select the string in the Tracewindow and enter the Search command (<SC>)

or press the Search button ; the selected string is copied to the Find field.
All occurrences of the specified string are highlighted in the Tracewindow and the
number of occurrences is displayed to the right of the Find field. If the content of
the Tracewindow is sufficiently long for there to be a vertical scroll bar, then the
locations of occurrences of the specified string within the entire content are
identified by yellowmarks overlaid on the scroll bar.

2. Press the Enter key to select the first occurrence of the search string after the last
position of the cursor.

3. Press the Search for next match button to advance the selection to the next
occurrence of the search string.

4. Repeat step 3 as required (the search is cyclic).
5. Press the Close button to exit the search functionality.

6.3.3 Exiting the TraceWindow

To close the Trace window:
l click in the Tracewindow's tab
l click in the Tracewindow's toolbar
l use the Escape command (<EP>)
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l use theQuit command (<QT>)
l press the Esc key

When the Tracewindow is closed, the function within that Tracewindow is removed from
the stack. It is possible to close all Trace/Editwindows without clearing the stack by
selecting theWindow > Close All Windowsmenu option or using 2023⌶ (for information
on this I-beam, see theDyalog APL Language Reference Guide).
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7 Working in a Dyalog Session

Themain purpose of a development environment is to enable a user to enter and execute
expressions; this chapter describes how this can be achieved when running a Dyalog
Session through the RIDE and explains the functionality that is provided to simplify the
process.

7.1 Keyboard Shortcuts and Command Codes
Keyboard shortcuts are keystrokes that execute an action rather than produce a symbol.
The RIDE supports numerous keyboard shortcuts, each of which is identified by a
command code and mapped to a keystroke combination; for example, the action to open
the Tracewindow is identified by the code TC (described in the documentation as <TC>).
For a complete list of the command codes that can be used in a Dyalog Session running
through the RIDE and the keyboard shortcuts for those command codes, see Appendix A.

Positioning the cursor over the button on the right hand side of the Language bar
displays a dynamic tooltip showing all configured keyboard shortcuts for command
codes. Clicking on the button displays the Preferences dialog box (the same as
selecting the Edit > Preferencesmenu option), through which keyboard shortcuts can be
customised (see Section 9.2.3).

7.2 Navigating the Windows
When multiple windows are open, the window that has the focus is referred to as the
activewindow. Awindow can bemade the active window by clicking within it.

The Session, Edit and Tracewindows form a closed loop for the purpose of navigation:
l to make the next window in this loop the active window, enter the Tab Window

command (<TB>)
l to make the previous window in this loop the active window, enter the Back Tab

Window command (<BT>)
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An active Edit/Trace window can be closed after changes have been made to its content:
l to save any changes in the content of the active window before closing it, enter the

Escape command (<EP>), press the button in its menu bar or, if the window is
docked, press in the window's tab.

l to discard any changes in the content of the active window before closing it, enter
theQuit command (<QT>)

7.3 Display of Windows
By default, the Tracewindow and Editwindows are docked beneath and to the right of
the Sessionwindow respectively. If themenu option View > Show Workspace Explorer is
checked, then the workspace explorer is docked to the far left of any open windows; if the
menu option View > Show Debug is checked, then the debug information window is
docked to the far right of any open windows (see Figure 5-2).

Docked windows can be selected (by clicking within them), resized (by moving the splitter
bar) and maximised/minimised (by toggling the icon at the top right of each window).

New Edit and Tracewindows can be floating rather than docked by selecting the Floating
windows checkbox in theWindows tab of the Preferences dialog box (see Section 9.2.7).

Clicking in the tab of any window enables that window to be dragged to a different
location.

7.4 Entering APL Characters
APL glyphs can be entered in a Dyalog Session running through the RIDE by:

l typing the glyph in the Sessionwindow or Editwindow using the appropriate key
combination (see Section 5.2).

l clicking the appropriate glyph on the Language bar (see Section 5.1.3) – this inserts
that glyph into the active Session/Editwindow at the position of the cursor.

When typing a glyph directly rather than using the Language bar, if you pause after
entering the prefix key then the autocomplete functionality (see Section 7.5.2) displays a
list of all the glyphs that can be produced. If you enter the prefix key a second time then a
list of all the glyphs that can be produced is again displayed but this timewith the names
(formal and informal) that are used for each glyph.

For example:

` ⍝ default prefix key

The autocomplete functionality list includes the following for the ⍟ glyph:
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⍟ `* ``logarithm
⍟ `* ``naturallogarithm
⍟ `* ``circlestar
⍟ `* ``starcircle
⍟ `* ``splat

This means that you can enter the ⍟ glyph by selecting (or directly typing) any of the
following:

`*
``logarithm
``naturallogarithm
``circlestar
``starcircle
``splat

As you enter a name, the autocomplete functionality restricts the list of options to those
that match the entered name. For example, entering:

``ci

restricts the list to:
⍟ `* ``circlestar
○ `○ ``circular
⌽ `% ``circlestile
⊖ `& ``circlebar
⍉ `^ ``circlebackslash
⍥ `O ``circlediaeresis

7.5 Entering Expressions
The RIDE provides several mechanisms that assist with accuracy and provide clarity when
entering expressions in a Dyalog Session.

7.5.1 Paired Enclosures

Applicable in the Session window and the Editwindow

Enclosures in the RIDE include:
l parentheses ( )
l braces { }
l brackets [ ]

Angle brackets < > are not enclosures.
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When an opening enclosure character is entered, the RIDE automatically includes its
closing pair. This reduces the risk of an invalid expression being entered due to
unbalanced enclosures. This feature can be disabled in theGeneral tab of the Preferences
dialog box (see Section 9.2.1).

7.5.2 Autocomplete

Applicable in the Session window and the Editwindow

The RIDE includes autocomplete functionality for names to reduce the likelihood of errors
when including them in an expression (and to save the user having to enter complete
names or remember cases for case-sensitive names).

As a name is entered, the RIDE displays a pop-up window of suggestions based on the
characters already entered and the context in which the name is being used.

For example, if you enter a ⎕ character, the pop-up list of suggestions includes all the
system names (for example, system functions and system variables). Entering further
characters filters the list so that only those system functions and variables that start with
the exact string entered are included.

When you start to enter a name in the Sessionwindow, the pop-up list of suggestions
includes all the namespaces, variables, functions and operators that are defined in the
current namespace. When you start to enter a name in the Editwindow, the pop-up list
of suggestions also includes all names that are localised in the function header.

To select a name from the pop-up list of suggestions, do one of the following:
l click themouse on the name in the pop-up list
l use the right arrow key to select the top name in the pop-up list
l use the up and down arrow keys to navigate through the suggestions and the right

arrow key or the TAB key to enter the currently-highlighted name

The selected name is then completed in the appropriate window.

This feature can be disabled or customised in theGeneral tab of the Preferences dialog
box (see Section 9.2.1).

7.5.3 Context-Sensitive Help

Applicable in the Session window, Editwindow and Tracewindow
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With the cursor on or immediately after any system command, system name, control
structure keyword or primitive glyph, enter theHelp command (<HLP>). The
documentation for that system command, system name, control structure keyword or
primitive glyph will be displayed.

7.5.4 Syntax Colouring

Applicable in the Editwindow and Tracewindow

Syntax colouring assigns different colours to various components, making them easily
identifiable. The default syntax colouring convention used is detailed in Table 7-1.

Colour Syntax

black global names

grey

names
namespaces
numbers
tradfn syntax (header line and final ∇ in scripted syntax)

maroon control structure keywords

red errors (including unmatched parentheses, quotes and braces)

teal
strings
comments

navy
primitive functions
zilde

blue

idioms (this takes priority over any other syntax colouring)
operators
parentheses/braces/brackets
dfn syntax (specifically, { } ⍺ ⍵ ∇ and :)
assignment (←), diamond (⋄) and semi-colon (;)

purple system names

Table 7-1: Syntax colouring convention (default)

Syntax colouring can be customised (see Section 9.2.4).
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7.6 Executing Expressions

7.6.1 Executing a New Expression

Applicable in the Session window

After entering a new expression in the input line, that expression is executed by pressing
the Enter key or with the Enter command (<ER>). Following execution, the expression
(and any displayed results) become part of the Session log.

7.6.2 Re-executing a Previous Expression

Applicable in the Session window

Instead of entering a new expression in the input line, you can move back through the
Session log and re-execute a previously-entered expression.

To re-execute a previously-entered expression

1. Locate the expression to re-execute in one of the following ways:
l Scroll back through the Session log.
l Use the Backward command (<BK>) and the Forward command (<FD>) to

cycle backwards and forwards through the input history, successively
copying previously-entered expressions into the input line.

2. Position the cursor anywhere within the expression that you want to re execute
and press the Enter key or use the Enter command (<ER>).

If required, a previously-entered expression can be amended prior to execution. In this
situation, when the amended expression is executed it is copied to the input line; the
original expression in the Session log is not changed. If you start to edit a previous
expression and then decide not to, use theQuit command (<QT>) to return the previous
expression to its unaltered state.

7.6.3 Re-executing Multiple Previous Expressions

Applicable in the Session window

Multiple expressions can be re-executed together irrespective of whether they were
originally executed sequentially (certain system commands cause re-execution to stop
once they have been completed, for example, )LOAD and )CLEAR).
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To re-execute multiple previously-entered expressions

1. Locate the first expression to re-execute in one of the following ways:
l Scroll back through the Session log.
l Use the Backward command (<BK>) and the Forward command (<FD>) to

cycle backwards and forwards through the input history, successively
copying previously-entered expressions into the input line.

2. Change the expression in someway. The change does not have to impact the
purpose of the expression; it could be an additional space character.

3. Scroll through the Session log to locate the next expression to re-execute and
change it in someway. Repeat until all the required expressions have been
changed.

4. Press the Enter key or enter the Enter command (<ER>).

The amended expressions are copied to the input line and executed in the order in which
they appear in the Session log; themodified expressions in the Session log are restored to
their original content.

To re-execute contiguous previously-entered expressions

1. Position the cursor at the start of the first expression to re-execute.
2. Press and hold themouse button (left-click) while moving the cursor to the end of

the last expression to re-execute.
3. Copy the selected lines to the clipboard using the Copy command (<CP>) or the Cut

command (<CT>) or the Copy/Cut options in the Editmenu.
4. Position the cursor in the input line and paste the content of the clipboard back

into the Session using the Paste command (<PT>), the Paste option in the Edit
menu or the Paste option in the context menu.

5. Press the Enter key or enter the Enter command (<ER>).

This technique can also be used to move lines from the Editwindow into the Session
window and execute them.

7.7 Threads
The RIDE supports multithreading. For information on threads, see theDyalog
Programming Reference Guide.

The number of threads currently in use is displayed in the Status bar (see Section 5.1.5).
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7.8 Suspending Execution
To assist with investigations into the behaviour of a set of statements (debugging), the
system can be instructed to suspend execution just before a particular statement. This is
done by setting a breakpoint – see Section 7.8.1.

It is sometimes necessary to suspend the execution of a function, for example, if an
endless loop has been inadvertently created or a response is taking an unacceptably long
time. This is done using an interrupt – see Section 7.8.2.

Suspended functions can be viewed through the stack; themost recently-referenced
function is at the top of the stack. The content of the stack can be queried with the )SI
system command; this generates a list of all suspended and pendent (that is, awaiting the
return of a called function) functions, where suspended functions are indicated by a *. For
more information on the stack and the state indicator, see theDyalog Programming
Reference Guide.

7.8.1 Breakpoints

Applicable in the Editwindow and the Tracewindow

When a function that includes a breakpoint is run, its execution is suspended immediately
before executing the line on which the breakpoint is set and the Tracewindow is
automatically opened (assuming that automatic trace is enabled – see Section 6.3).

Breakpoints are defined by dyadic ⎕STOP and can be toggled on and off in an Edit or
Tracewindow by left-clicking on the far left of the line before which the breakpoint is to be
applied or by placing the cursor anywhere in the line before which the breakpoint is to be
applied and entering the Toggle Breakpoint command (<BP>). Note that:

l Breakpoints set or cleared in an Editwindow are not established until the function
is fixed.

l Breakpoints set or cleared in a Tracewindow are established immediately.

When a breakpoint is reached during code execution, event 1001 is generated; this can be
trapped. For more information, see ⎕TRAP in theDyalog APL Language Reference Guide.

7.8.2 Interrupts

ADyalog Session running through the RIDE responds to both strong and weak interrupts.
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Entering a strong interrupt suspends execution as soon as possible (generally after
completing execution of the primitive currently being processed). A strong interrupt is
issued by selecting Actions > Strong Interrupt in themenu options or by entering the
Strong Interrupt command (<SI>).

Entering a weak interrupt suspends execution at the start of the next line (generally after
completing execution of the statement currently being processed). Aweak interrupt is
issued by selecting Actions > Weak Interrupt in themenu options or by entering the
Weak Interrupt command (<WI>).

When a strong or weak interrupt is issued during code execution, event 1003 or
1002 (respectively) is generated; these can be trapped. For more information, see
⎕TRAP in theDyalog APL Language Reference Guide.

7.9 Terminating a Dyalog Session Running Through
the RIDE
The Dyalog Session can be terminated (without having to close any open windows first) in
any of the following ways:

l From themenu options:
o Linux: Select File > Quit
o macOS: Select Dyalog > Quit Dyalog
o Microsoft Windows: Select File > Quit

l Enter:
o Linux: Ctrl + Q
o macOS :⌘ + Q
o Microsoft Windows: Ctrl + Q

(only if the Dyalog Unicode IME is not enabled – see Section 9.2.2)

In addition, when the Sessionwindow is the active window, the Dyalog Session can be
terminated cleanly in any of the following ways:

l Enter )OFF
l Enter ⎕OFF
l Enter <QIT>
l macOS:⌘ + W
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8 RIDE-Specific Language Features

When running a Dyalog Session through the RIDE, themajority of language features
remain unaltered. However, there are a few additional features and some existing
functionality that is meaningless when a Session is running through the RIDE.

8.1 I-Beams
I-Beam is a monadic operator that provides a range of system-related services.

Syntax: R←{X}(A⌶)Y

Any service provided using an I-Beam should be considered as experimental and
subject to change – without notice – from one release to the next. Any use of I-
Beams in applications should, therefore, be carefully isolated in cover-functions
that can be adjusted if necessary.

There are three I-Beams that are only relevant to the RIDE.

8.1.1 3500⌶ (Send HTML to the RIDE)

Syntax: R←{X}(3500⌶)Y

Optionally, X is a simple character vector or scalar, the contents of which are used as the
caption of an embedded browser window opened by the RIDE client. If omitted, then the
caption defaults to "3500⌶".

Y is a simple character vector of HTMLmarkup, the contents of which are displayed in the
embedded browser tab.

R identifies whether the write to the RIDE was successful. Possible values are:
l  0 : the write to the RIDE client was successful
l ¯1 : the RIDE client is not enabled
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8.1.2 3501⌶ (Connected to the RIDE?)

Syntax: R←{X}(3501⌶)Y

X and Y can be any value (ignored).

R identifies whether the Dyalog Session is running through the RIDE. Possible values are:
l 0 : the Session is not running through the RIDE
l 1 : the Session is running through the RIDE

8.1.3 3502⌶ (Manage RIDE Connectors)

By default, the RIDE is not enabled on run-time executables. For security reasons,
enabling the RIDE is a two-step process rather than using (for example) a single
configuration parameter. To enable the RIDE, two steps must be taken:

1. Set the RIDE_INIT configuration parameter (see Section 8.2.2) on the
machine on which the run-time interpreter is running to an appropriate
value.

2. Execute 3502⌶1 in your application code.

The run time interpreter can then attempt to connect to a RIDE client.

Enabling the RIDE to access applications that use the run-time interpreter means
that the APL code of those applications can be accessed. The I-beam mechanism
described abovemeans that the APL code itself must grant the right for a RIDE
client to connect to the run time interpreter. Although Dyalog Ltd might change
the details of this mechanism, the APL code will always need to grant connection
rights. In particular, no mechanism that is only dependent on configuration
parameters will be implemented.

Syntax: R←3502⌶Y

R is 0 if the call is successful, otherwise an integer (positive or negative) is returned.

Y can be any of the following possible values:
l 0 : disable any active RIDE connections.

o R is always 0
l 1 : enable the RIDE using the initialisation string defined in the RIDE_INIT

configuration parameter (see Section 8.2.2):
o if R is 0, then the RIDE was disabled and is now successfully enabled
o if R is ¯1, then the RIDE was already active
o if R is 32, then the RIDE DLL/shared library is not available
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o if R is 64, then the RIDE_INIT configuration parameter is not correctly
defined

l a simple character vector : replace the RIDE_INIT configuration parameter with the
specified initialisation string, which should be in the format specified in
Section 8.2.2. For example, 3502⌶'SERVE:*:4502' configures the interpreter to
accept incoming RIDE connections from any machine on port 4502, and then
enables the RIDE with that configuration.

o if R is 0, then the RIDE was disabled
o if R is ¯2, then the RIDE was active

On a run-time interpreter, 3502⌶1 is the only way to enable the RIDE.

If the RIDE_INIT configuration parameter is set but the RIDE DLLs/shared libraries
are not available, then a run-time interpreter will start but the subsequent call to
3502⌶will be unsuccessful.

8.2 Configuration Parameters
There are two configuration parameters that are relevant to the RIDE:

l RIDE_EDITOR (set on themachine that the RIDE is running on)
l RIDE_INIT (set on themachine that the interpreter is running on)

8.2.1 RIDE_EDITOR

The fully-qualified path to the executable of the editor to use in a Dyalog Session instead
of the RIDE's built-in editor (for example, vim, Emacs or Notepad++).

8.2.2 RIDE_INIT

How the interpreter should behave with respect to the RIDE protocol. Setting this
configuration parameter on themachine that hosts the interpreter enables the
interpreter-RIDE connection.

The format of the value is {mode:setting}[,mode:setting]

where mode is the action that the interpreter should take and determines the content of
the setting. Valid (case-insensitive) values are:

l SERVE – listen for incoming connections from the RIDE client
l CONNECT – attempt to connect to the specified RIDE client and end the session if

this fails
l POLL – attempt to connect to the specified RIDE client at regular intervals and

reconnect if the connection is lost

revision20200707_430 53

RIDE User Guide



l HTTP – listen for incoming connections from the web browser (zero footprint RIDE
– see Section 4.2)

l CONFIG – retrieve values to use from a .ini configuration file (see Section 3.3)

If two modes are specified, then:
l one of themodes must be CONFIG.
l the SERVE/CONNECT/POLL/HTTP values always override the equivalent

values in the .ini configuration file.

If mode is SERVE or HTTP, then setting is address:port, where:
l address is the address of the interface on which themachine running the APL

process should listen (that is, the address of themachine that is running the
interpreter). Valid values are:

o <empty> – listen on all loopback interfaces, that is, the interpreter only
accepts connection from the local machine

o * – listen on all local machine interfaces, that is, the interpreter listens for
connections from any (local or remote)machine/interface

o the host/DNS name of themachine/interface running the interpreter – listen
on that specific interface on the local machine

o the IPv4 address of themachine/interface running the interpreter – listen on
that specific interface on the local machine

o the IPv6 address of themachine/interface running the interpreter – listen on
that specific interface on the local machine

l port is the TCP port to listen on

If mode is CONNECT or POLL, then setting is address:port, where:
l address is the destination address to attempt to connect to (the

machine/interface running the RIDE client). Valid values are:
o the host/DNS name of a machine/interface running the RIDE client
o the IPv4 address of a machine/interface running the RIDE client
o the IPv6 address of a machine/interface running the RIDE client

l port is the TCP port to connect to

If mode is CONFIG, then setting is filename, where:
l filename is the fully-qualified path to, and name of, a .ini configuration file

containing name-value pairs related to mode, certificate details, and so on. The
default value for setting is ride.ini (for more information on the .ini
configuration file, see Section 3.3).
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EXAMPLES

To listen on port 4502 for connection requests from a RIDE client running on any machine:
RIDE_INIT=SERVE:*:4502

To attempt to connect to a RIDE client running on a different machine (with IPv4 address
10.0.38.1 and listening on port 4502) and end the Session if unable to do so:
RIDE_INIT=CONNECT:10.0.38.1:4502

To establish a connection using the settings in the ride_sample.ini file:
RIDE_INIT=CONFIG:C:/tmp/ride_sample.ini

To attempt to establish a secure connection with a RIDE client running on a different
machine (with IPv4 address 10.0.38.1 and listening on port 4502) using certificate details
specified in the ride_sample.ini file:
RIDE_INIT=CONFIG:C:\tmp\ride_sample.ini,CONNECT:10.0.38.1:4502
or
RIDE_INIT=CONNECT:10.0.38.1:4502,CONFIG:C:\tmp\ride_sample.ini

With Dyalog and the RIDE installed on a machine with IPv4 address 10.0.38.1, to listen on
port 4502 for connection requests from a web browser running on any machine (Zero
Footprint RIDE – see Section 4.2):
RIDE_INIT=HTTP:*:4502
To open the Zero Footprint RIDE in a web browser on:

l the local machine : URL = http://localhost:4502
l a different machine: URL = http://10.0.38.1:4502

The RIDE_INIT configuration parameter is set automatically when launching a newDyalog
Session from the RIDE (see Section 4.1.3.1).

If the RIDE_INIT configuration parameter is set but the RIDE DLLs/shared libraries
are not available, then a run-time interpreter will start but the subsequent call to
3502⌶will be unsuccessful – see Section 8.1.3.

8.3 Unsupported Language Elements
When running a Dyalog Session through the RIDE, a few of the features that are available
with non-RIDE Sessions do not function as might be expected.
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8.3.1 Underscored Characters

Underscored characters can be entered into the Sessionwindow and Editwindows using
the ``_<letter>method, for example, enter ``_f to produce Ⓕ.

8.3.1.1 Underscored Characters in Window Captions

The RIDE is restricted by the operating system when it comes to displaying underscored
characters in window titles (captions). This restriction means that:

l if the APL385 font is installed (and the operating system has been configured to
allow the title bar to use it), underscored characters are displayed as circled
characters.

l if the APL385 font is not installed, underscored characters are displayed as a white
rectangle, a black rectangle containing a question mark, or some other Unicode-
compliant substitution.

EXAMPLE:

Open an Editwindow for an object that has an underscored name:
)ed Ⓐ

The Editwindow that is opened displays the name correctly, but its title (caption) is
displayed incorrectly, as shown below (assuming window is docked):

8.3.1.2 Underscored Characters in the Session

If the RIDE is connected to a Unicode edition of Dyalog, then underscored characters are
displayed correctly in the Sessionwindow, Editwindows and Tracewindows. If the RIDE is
connected to a classic edition of Dyalog, then the following command must be run in
every APL Session to enable the underscored alphabet to be displayed correctly:

⎕IO←0
⎕AVU[97+⍳26]←9398+⍳2
2 ⎕NQ '.' 'SetUnicodeTable' ⎕AVU
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8.3.2 Function Key Configuration

Character strings (including command keys) can be associated with programmable
function keys using the ⎕PFKEY system function. When running a Dyalog Session
through the RIDE, ⎕PFKEY can be used to define/display the keystrokes for a designated
function key; however, that function key does not acquire the defined set of keystrokes,
rendering ⎕PFKEY of no real use. Instead, function keys should be set through the
Shortcuts tab of the Preferences dialog box (see Section 9.2.3).

8.3.3 Operating System Terminal/Command Window Interaction

Features that rely on interaction with an operating system terminal/command window
(that is, ⎕SR and )SH or )CMDwith no argument) cannot work in a Dyalog Session that is
running through the RIDE. Instead of behaving as documented in theDyalog APL
Language Reference Guide, their behaviour depends on the way in which the interpreter
and the RIDE combined to start a Dyalog Session:

l If the interpreter was started by the RIDE (see Section 4.1.3.1), then:
o ⎕SR generates a trappable error
o )SH or )CMDwith no argument produces a "Feature disabled in this

environment" message.
l If the interpreter and the RIDE were started independently and then connected to

each other (see Section 4.1.3.2 and Section 4.1.3.3), then the use of these features
will appear to hang the Dyalog Session that is running through the RIDE. However,
the Dyalog Session can be recovered by locating the operating system
terminal/command window and using it to complete the operation. If there is no
operating system terminal/command window, then the Dyalog Session is
irrecoverable.
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9 Customising Your Session

The appearance and behaviour of a Dyalog Session running through the RIDE can be
customised to meet personal preferences and corporate guidelines. Configuration can be
performed:

l through the Viewmenu – see Section 9.1
l through the Preferences dialog box – see Section 9.2
l using configuration parameters – see Section 9.3

Customisations performed using any of thesemethods persist between Sessions (they
also persist when the installed version of Dyalog is upgraded).

To remove all customisations, reset all RIDE-specific settings and return to the
initial default settings, rename/delete the following directory:

l Linux: $HOME/.config/Ride-<version>
l macOS: $HOME/Library/Application Support/Ride-<version>

(hidden directory – access from the command line)
l Microsoft Windows:%APPDATA%\Ride-<version>

9.1 View Menu
The Viewmenu includes options that enable the appearance of the Dyalog Session
running through the RIDE to be changed. Select these options to:

l show/hide the Language bar (see Section 5.1.3)
l show/hide the Status bar (see Section 5.1.5)
l show/hide theWorkspace Explorer (see Section 5.1.6)
l show/hide the debug information window (see Section 5.1.7)
l change the font size in all windows in the Session
l configure the display/functionality of the Edit/Tracewindows

revision20200707_430 58

RIDE User Guide



9.2 Preferences Dialog Box
The Preferences dialog box can be used to customise:

l the automatic formatting of text in an Editwindow (see Section 9.2.1)
l the default keyboard key mappings for APL glyphs (see Section 9.2.2)
l the keyboard shortcuts for command codes (see Section 9.2.3)
l the syntax colouring and background colour (see Section 9.2.4)
l the caption of the Sessionwindow (see Section 9.2.5)
l themenu options presented by themenu bar (see Section 9.2.6)
l the display of floating Edit/Tracewindows (see Section 9.2.7)

The Preferences dialog box can be opened in any of the following ways:
l selecting the Edit > Preferencesmenu option
l clicking the icon on the left hand side of the Status bar
l clicking on the button on the right hand side of the Language bar
l entering the Show Preferences command (<PRF>)

The Preferences dialog box comprises multiple tabs. The button enables the contents
of the Keyboard and Shortcuts tabs to be printed.

9.2.1 General Tab

Allows customisation of a variety of features.

To change the general configuration options

1. Open theGeneral tab.
2. Select the appropriate check boxes and set the variables as required:

l Indent content when an editor is opened
Select this to apply the indentation rules to the contents of an Editwindow
when it is opened.

l Handle formatting through the interpreter
Select this to use the interpreter to reformat code. This is useful to avoid
formatting changes that could be detected by source codemanagement
systems when the RIDE is used to maintain a body of code that is also edited
directly using the interpreter.

l Auto-indent <number> spaces
Only relevant when Handle formatting through the interpreter is not
selected. Select this and define the number of spaces by which each level of
nested code should be indented relative to the previous level of indentation
in the Editwindow. If not selected, code in the Editwindowwill be left
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justified.
o in methods: <number> spaces

Only relevant when Handle formatting through the interpreter is not
selected. Select this and define the number of spaces by which the
contents of tradfns should be indented relative to the start/end ∇
glyphs.

When changes to auto-indentation are applied, the indentation of existing
code in an open Editwindow does not change unless you enter the
Reformat command (<RD>) when the Editwindow is the active window.
However, any new code entered in the Editwindow follows the new rules.

l Indent lines that contain only a comment
Only relevant when Handle formatting through the interpreter is not
selected. Select this to apply the appropriate indentation to lines that start
with the ⍝ glyph. If this is not selected, then lines that start with the ⍝ glyph
remain as positioned by the user.

l Highlight matching brackets: () [] {}
Select this to automatically highlight thematching start and end enclosures
when positioning the cursor before or after one of them (with contiguous
brackets, the bracket immediately before the cursor has its other enclosure
highlighted).

l Auto-close brackets
Select this to automatically add the paired enclosure when an opening
enclosure is entered (see Section 7.5.1).

l Autocompletion
Select an autocompletion option from the drop-down list (autocompletion
makes suggestions when entering the name of, for example, namespaces,
variables, functions, operators, user commands and system names).
Options include:

o off – disables autocomplete functionality.
o classic – displays a pop-up window of suggestions based on the

characters already entered and the context in which the name is
being used (see Section 7.5.2).

o shell – resembles the autocomplete functionality of the Linux bash
shell in its use of the tab key.

l Autocompletion after <time>ms
Specify a time interval after which the RIDE's autocompletion functionality is
activated.

l Autocomplete control structure with snippets
Select this to be presented with auto-completion template options for
control structures in the Editwindow.
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l Highlight matching words
Select this to highlight all occurrences of a selected string in the same
window.

l Show value tips
Select this to display the referent of a name. When the cursor is positioned
over or immediately after a name, the name is highlighted and its referent is
displayed (for example, the value of a variable or the body of a function).

l Show tips for glyphs
Select this to show the tooltip for a glyph. When the cursor is positioned
over or immediately after a glyph, the glyph is highlighted and information
about it is displayed – this includes the name of the glyph, the keyboard
shortcut to enter it, its monadic/dyadic name and examples of its syntax,
arguments and result.

l Auto PW
Select this to display text in the Sessionwindow up to the full width of the
Sessionwindow before wrapping (automatically updates when the Session
is resized). Also sets ⎕PW to this value.

l Persistent history <number> lines
Select this and define the number of lines that are available to recall using
the Backward/Undo command (<BK>). This specifies howmany input lines
RIDE remembers from the end of one RIDE session to the start of the next
session.

l Block cursor
Select this to display the cursor as a solid rectangular block rather than a
vertical line.

l Cursor blinking
Select a cursor animation from the drop-down list (for example, blink or
solid).

l Highlight current line
Select an option from the drop-down list to indicate how the line that the
cursor is currently positioned on should be emphasised (applies to all
windows). Options include:

o none – do not indicate the current line.
o gutter – display a small grey rectangle in the first column of the line.
o line – display a grey rectangle around the entire line except the first

column.
o all – gutter and line.

l Minimap enabled
Select this to display a dynamic impression of the entire (or very large
portion of) contents of the Session/Editwindow in a column on the
right-hand side of that window. Clicking within theminimap moves the
display to that location.
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l Minimap render characters
Only relevant whenMinimap enabled is selected. Select this to use tiny
rendered font in theminimap rather than greeking (showing a
representation of the text).

l Minimap show slider
Only relevant whenMinimap enabled is selected. Select an option from the
drop-down list to indicate how the currently-displayed content of the
window is highlighted in theminimap. Options include:

o always – the current display is always highlighted in theminimap.
o mouseover – the current display is only highlighted in theminimap

when themouse is positioned over theminimap.
l Show quit prompt

Select this to display a confirmation dialog box when exiting the RIDE
session.

l Show toolbar in editor/trace windows
Select this to display the toolbar in the Edit/Tracewindows.

l Connect on quit
Select this to be returned to the RIDE-Dyalog Session dialog box on exiting a
Session.

3. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

Settings that impact the automatic reformatting of code can cause changes to
whitespace – this can be interpreted as changes to the source code. This means
that:

l opening a scripted object in the Editwindow can cause the source of that
object to change (when closing an Editwindow, you might be prompted to
save a function even though you have not made any changes to it).

l viewing an object can change its file timestamp; source codemanagement
systems can subsequently report changes due to the changed file
timestamp.

l source code changes resulting from reformatting will be evident in the
results of system functions such as ⎕AT, ⎕SRC, ⎕CR, ⎕VR and ⎕NR.

9.2.2 Keyboard Tab

Allows customisation of the default keyboard key mappings for APL glyphs (see
Section 5.2). This is only relevant if a locale-specific keyboard has not been installed.
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To replace the keyboard with a locale-specific keyboard in the Session, or to enter
Dyalog glyphs in other applications (for example, email), see
http://www.dyalog.com/apl-font-keyboard.htm.

If you have the Dyalog Unicode IME installed, then the RIDE activates it at start-up
when the Also enable Dyalog IME (requires RIDE restart) checkbox is selected
(selected by default).

If Dyalog is not installed on themachine that the RIDE is running on, then the
Dyalog Unicode IME can be downloaded and installed from
http://www.dyalog.com/apl-font-keyboard.htm.

Most Linux distributions released after mid-2012 support Dyalog glyphs by default,
for example, openSUSE 12.2, Ubuntu 12.10 and Fedora 17. For more information,
see theDyalog for UNIX Installation and Configuration Guide.

To customise the default keyboard's Prefix key

1. Open the Keyboard tab and select the appropriate keyboard from the drop down
list of options.

2. In the Prefix key field, enter the new prefix key (by default this is `).

In locales in which ` is a dead key, $ is a viable alternative.

Be careful when selecting a new prefix key – although there are no restrictions,
choosing certain keys (for example, alphanumeric characters) would restrict the
information that could be entered in a Session.

3. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

To customise the default keyboard's key mappings

1. Open the Keyboard tab and select the appropriate keyboard from the drop down
list of options.

2. In the image of a keyboard, click on the glyph to be replaced (bottom right of the
key for unshifted mode and top right of the key for shifted mode).

3. Enter the glyph to replace the selected glyph with.
4. Repeat steps 2 and 3 until the key mappings are as required.

revision20200707_430 63

RIDE User Guide

http://www.dyalog.com/apl-font-keyboard.htm
http://www.dyalog.com/apl-font-keyboard.htm


5. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

Your selection of keyboard key mappings is unrestricted – you can choose to map the
same glyph to multiple keys or have glyphs that are not represented on the keyboard at
all. For example, when dealing with dfns on a Danish keyboard, it might be convenient to
map { and } to a simpler key combination.

9.2.3 Shortcuts Tab

Allows customisation of the keyboard shortcuts for command codes (see Section 7.1 and
Appendix A). Multiple shortcuts can be defined for any command code, but each shortcut
must be unique.

To change the keyboard shortcut for a command code

1. Open the Shortcuts tab.
2. Locate the command code for which you want to define a new keyboard shortcut.

This can be done by scrolling through the list of possible command codes or by
entering a string in the Search field. If a string is entered in the Search field then a
dynamic search of both the command codes and descriptions is performed.

3. Optionally, delete any existing shortcuts for the command by clicking the red cross
to the right of the shortcut.

4. Optionally, add a new shortcut. To do this:
i. Click the plus symbol that appears to the right of any existing shortcuts

when the shortcut is moused over.
A field in which to enter the shortcut is displayed.

ii. In this field, enter the keystrokes to map to this action. The field closes when
the keystrokes have been entered and the new shortcut is displayed on the
Shortcuts tab.
If the keystrokes that you enter are already used for a different command
code, then both occurrences will be highlighted and you should remove any
duplicate entries (an error message will be displayed if you attempt to
apply/save settings that contain duplicate entries).

5. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.
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The tooltip showing keyboard shortcuts for command codes (obtained by positioning the
cursor over the button on the right hand side of the Language bar) is dynamically
updated to any customisation.

9.2.4 Colours Tab

Allows customisation of the syntax colouring (see Section 7.5.4). Several schemes are
provided, any of which can be used as they are or further customised.

To change the syntax colouring to a predefined scheme

1. Open the Colours tab.
2. In the Scheme field, select the syntax colouring scheme that you want to use.

When a scheme is selected, the example shown is updated to use that colour
scheme.

3. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

To define a new syntax colouring scheme

1. Open the Colours tab.
2. In the Scheme field, select the syntax colouring scheme that is closest to the

scheme that you want to define. When a scheme is selected, the example shown is
updated to use that colour scheme.

3. Click Clone.

A copy is made of the selected scheme and additional options are displayed to
allow customisation of the scheme's name and syntax colouring.

4. Define your colour scheme. To do this:
i. Select the element that you would like to change the display of from the

drop-down list or by clicking in the example. The customisation options
reflect the current settings for the selection made. Some elements have a
limited set of options, for example, the cursor element has no
bold/italic/underline option.

ii. Select a foreground colour and background (highlighting) colour for that
syntax as required. If a background colour is selected, then the slide bar can
be used to set its transparency.

iii. Select the appropriate check boxes to make that syntax bold, italic or
underlined as required.

iv. Repeat as required.
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5. Optionally, rename your colour scheme. To do this:
i. Click Rename.

The name in the Scheme field becomes editable.
ii. Edit the name in the Scheme field.

6. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

9.2.5 Title Tab

Allows customisation of the caption at the top of the Session (see Section 5.1.1).

To change the caption

1. Open the Title tab.
2. In theWindow title field, enter the new name for the Session. Some variable

options that can be included are listed beneath this field – clicking on these inserts
them into theWindow title field.

3. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

The default value is {WSID}.

Changing this to {WSID} – {HOST}:{PORT} (PID: {PID}) gives a different result on
every machine. For example:

/Users/nick/myws.dws – 127.0.0.1:4502 (PID: 293)

Changing this to {CHARS} {BITS} gives information that could be the same on multiple
machines. For example:

Unicode 64

9.2.6 Menu Tab

Allows customisation of themenu options in themenu bar (see Section 5.1.2).
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Great care should be taken when customising themenu options; although the
ability to make changes is provided, it is not an activity that Dyalog Ltd supports.

If menu options are customised, then updates to menu items are ignored when
updating the installed version of RIDE (this can be avoided by resetting themenu
options before upgrading RIDE).

Top-level options (menu names in themenu bar) can be:
l created
l renamed
l reordered
l deleted

Options within each of themenus can be:
l moved to be under a different menu name in themenu bar
l reordered under the samemenu name in themenu bar
l renamed
l deleted

Changes do not take effect until the next time a Dyalog Session is started through the
RIDE.

9.2.7 Windows Tab

Allows customisation of the size and position of floating Edit/Tracewindows.

To change the size/position of floating Edit/Trace windows

1. Open theWindows tab.
2. Select the appropriate check boxes and set the variables as required:

l Floating windows
Toggles whether new Edit and Tracewindows are docked inside the Session
or floating (undocked). The remaining fields on this tab are only relevant if
windows are floating, that is, this option is selected.

l Single floating window
Select this to display a single floating windowwith multiple tabs for different
Edit/Tracewindows. If this option is not selected, then multiple floating
windows are displayed for individual Edit/Tracewindows.

l Remember previous window position
Select this to open new floating windows in the positions that were occupied
by previously-opened windows when they were closed. The location of the
first floating window opened persists between sessions.
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l Size width and height
Specifies the width and height of new Edit and Tracewindows.

l Posn x and y
Specifies the x-y co-ordinates of the screen position for the top left corner of
the first Edit/Tracewindow opened.

l Offset x and y
Specifies the x-y offsets for the top left corner of Edit/Tracewindows opened
relative to the previously-opened window. Only relevant if Single floating
window is not selected.

3. Click OK to save your changes and close the Preferences dialog box, Apply to save
your changes without closing the Preferences dialog box or Cancel to close the
Preferences dialog box without saving your changes.

9.3 Configuration Parameters
Some customisation can be performed using configuration parameters outside a Session.
For details of other configuration parameters that can be set, and the syntax used to set
them, see theDyalog for <operating system> Installation and Configuration Guide
specific to the operating system that you are using.

Changes made to configuration parameters in the dyalog.config file only impact
local interpreters (that is, interpreters that are configured by that file) and do not
impact interpreters that the RIDE can connect with on other machines.
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A Keyboard Shortcuts

The Dyalog keyboard shortcuts that are supported by the RIDE are listed in Table A-1;
those that can be configured in the Shortcuts tab of the Preferences dialog box (see
Section 9.2.3) are indicated with a * character.

Code Command
Default

Keystrokes
Description

ABT* About Dyalog Shift + F1 Display the About Dyalog dialog box

AC*
Align
comments

Edit: Align comments to current column

AO*
Comment
out lines

Session/Edit: Add comment symbol at start of
each tagged or current line

BH*
Run to exit (in
tracer)

Trace: Continue execution from the current line
to completion of the current function or
operator. If successful, the selection advances
to the next line of the calling function (if there is
one).

BK*
Backward or
Undo

Ctrl + Shift
+ Backspace

Session: Show previous line in input history
Edit: Undo last change (where possible)
Trace: Skip back one line

BP*
Toggle
breakpoint

Edit/Trace: Toggle a breakpoint on the current
line

Table A-1: Dyalog keyboard shortcuts supported on the RIDE
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Code Command
Default

Keystrokes
Description

BT*
Back Tab
between
windows

Ctrl + Shift
+ Tab

Move to previous window in loop

CAM*

Clear all
trace/
stop/monitor

Remove any trace/stop/monitor flags (as set
by ⎕TRACE, ⎕STOP and ⎕MONITOR) from all
functions in the workspace

CAW*
Close all
windows

Close all open Edit and Tracewindows

CBP*
Clear stops
for active
object

Edit/Trace: Clear all breakpoints (resets ⎕STOP)
on the function(s).

CNC* Connect
Display the RIDE-Dyalog Session dialog box
(see Section 4.1)

CP Copy

Linux: Ctrl
+ C
macOS:⌘
+ C
Windows:
Ctrl + C

Session/Edit: Copy highlighted block of text to
the clipboard

CT Cut

Linux: Ctrl +
X
macOS:⌘
+ X
Windows:
Ctrl + X

Session/Edit: Delete highlighted block of text
and place it on the clipboard

DB Backspace Backspace Delete character to left of cursor

DC Down cursor
Down
Arrow

Move cursor down one character

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

DI Delete item

Linux:
Delete
macOS: Fn
+ Backspace
Windows:
Delete

Delete character to right of cursor

DK* Delete lines Delete
Session/Edit: Delete current line (or selected
lines if selection exists)

DL Down limit

Linux: Ctrl +
End
macOS:⌘
+ Down
Arrow
Windows:
Ctrl + End

Session: Move cursor to bottom right corner of
Session log
Edit: Move cursor to bottom right corner of
content

DMK*
Toggle key
display mode

Functionality that could be useful when
presenting demonstrations.
Enables you to display your keystrokes and
load/run a demo file.
For more information on presenting
demonstrations, enter ]Demo -? in a Session.

DMN*
Next line in
demo

DMP*
Previous line
in demo

DMR*
Load demo
file

DO*
Uncomment
lines

Session/Edit: Remove comment symbol that is
first non space character on each tagged or
current line

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

DS Down screen

Linux: Page
Down
macOS: Fn
+ Down
Arrow
Windows:
Page Down

Move cursor down one screen

ED* Edit Shift + Enter

Session: Open an Editwindow (if there is a
suspended function on the stack, this opens an
Editwindow for that function – this is called
Naked Edit)
Edit (a class or namespace): Move the cursor to
the definition of the name under or
immediately before/after the cursor (also see
<JBK>)
Edit (not a class or namespace): Open a new
Editwindow for the name under or
immediately before/after the cursor

EP*
Exit and save
changes

Escape
Edit: Fix and Close
Trace: Cut stack back to calling function; close
all windows to match new stack status

ER* Execute line Enter
Session: Execute current line/all modified lines
Edit: Insert new line
Trace: Execute current line

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

EXP*
Expand
Selection

Shift + Alt +
Up Arrow

Successive presses of <EXP> expand the
highlighted selection

Session: select the:
l current line
l entire Session log

Edit: select the:
l current token (number, name, string,

and so on)
l current line
l entire contents of window

FD*
Forward or
Redo

Ctrl + Shift +
Enter

Session: Show next line in input history
Edit: Reapply last change
Trace: Skip current line

FX*
Fix the
current
function

Edit: Fixes the function without closing the Edit
window

HLP* Help F1

Display the documentation for the system
command, system name, control structure
keyword or primitive glyph immediately to the
left of the cursor

HO Home cursor

Linux: Ctrl +
Home
macOS:⌘
+ Up Arrow
Windows:
Ctrl + Home

Session: Move cursor to top left corner of
Session log
Edit: Move cursor to top left corner of content

JBK* Jump back
Ctrl + Shift +
J

Edit (a class or namespace): move the cursor
back to where the last double-click or Edit
command (<ED>) was issued in the current Edit
window. Repeatable.

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

JSC*
Show
JavaScript
Console

F12
Display the JavaScript console. Only necessary
if requested by Dyalog Ltd. when reporting an
issue.

LBR*
Toggle
Language bar

Toggle display of the Language bar (see
Section 5.1.3) at the top of the Sessionwindow

LC Left cursor Left Arrow Move cursor left one character

LL Left limit

Linux:
Home
macOS: Fn
+ Left Arrow
Windows:
Home

Move cursor to the first non-blank character on
the current line. If already there, move cursor
to start of line.

LN*
Toggle line
numbers

Turn line numbers on/off in all windows of the
same type as the active window

LOG*
ShowRIDE
protocol log

Ctrl + F12
Display the RIDE protocol log. Only necessary if
requested by Dyalog Ltd when reporting an
issue.

MA*
Continue
execution of
all threads

Restart execution of any paused or suspended
threads. For information on threads, see the
Dyalog Programming Reference Guide.

NEW* New Session Ctrl + N
Starts a newDyalog Session (a new instance of
the interpreter)

NX* Next match
Edit/Trace: When performing a
Search/Replace, locate first match after current
one

PF1*
Function Key
1

<user-defined functionality>

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

PF2* -
PF10*

Function
Keys 2 - 10

F2 - F10 <user-defined functionality>

PF11* -
PF48*

Function
Keys 11 - 48

<user-defined functionality>

PRF*
Show
preferences

Display the Preferences dialog box (see
Section 9.2)

PT Paste

Linux: Ctrl +
V
macOS:⌘
+ V
Windows:
Ctrl + V

Session/Edit: Paste the text contents of the
clipboard at cursor

PV*
Previous
match

Edit/Trace: When performing a
Search/Replace, locate first match before
current one

QCP
Quick
Command
Palette

Expose the underlying (Monaco) editor
command palette

QIT* Quit Session Ctrl + Q Terminate the Dyalog Session

QT*
Close window
(and lose
changes)

Shift +
Escape

Session: Undo changes to a previously-entered
expression that has not been re-executed and
advance the cursor to the next line
Edit: Close without saving changes

RC Right cursor Right Arrow Move cursor right one character

RD* Reformat
Edit: Formats function to have correct
indentation and spacing between tokens

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

RL Right limit

Linux: End
macOS: Fn
+ Right
Arrow
Windows:
End

Move cursor to the last non-blank character on
the current line. If already there, move to end
of line.

RP*
Replace
string

Edit: Replace. To do this, enter <RP> and type
the string to replace the current search string
with (see <SC>); enter <ER> to make the
change. Enter <EP> to clear the field.

SA* Select all

Linux: Ctrl +
A
macOS:⌘
+ A
Windows:
Ctrl + A

Select all text in the active window

SBR*
Toggle Status
bar

Toggle display of the Status bar (see
Section 5.1.5) at the bottom of the Session
window and floating Edit/Tracewindows.

SC* Search Ctrl + F

Edit/Trace: Search. To do this, enter <SC>, type
the string to search for and then enter <ER> to
find the first occurrence of the string. Enter
<EP> to clear the field.
Also see related <NX>, <PV> and <RP>.

SI*
Strong
interrupt

Suspend code execution as soon as possible
(generally after completing execution of the
primitive currently being processed)

STL* Skip to line
Trace: Move the current execution marker to
the line on which the cursor is positioned

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

TB*
Tab between
windows

Ctrl + Tab Move to next window in loop

TC* Trace line Ctrl + Enter

Session: If entered directly after an expression,
open a Tracewindow for that expression
(explicit trace). If there is a suspended function
on the execution stack, open a Tracewindow
for that function (naked trace).

TGC*
Toggle
comment

Session/Edit: Toggle a comment glyph at the
start of the line in which the cursor is located

TIP*
Show value
tips

For the name or glyph under or immediately
before the cursor, highlight that name/glyph
and display:

l for a name: its referent (for example, the
value of a variable or the code of a
function)

l for a glyph: the name of the glyph, the
keyboard shortcut to enter it, its name
and examples of its syntax, arguments
and result

TL*
Toggle
localisation

Ctrl + Up
Arrow

Edit: For tradfns, the name under the cursor is
added to or removed from the list of localised
names on the function's header line

TO* Toggle fold
Edit: Open/Close outlined blocks (by default,
outlines are shown)

TVB*
Toggle view
steps

Edit/Trace: Toggle display of an additional
column at the left-hand side of the window in
which break-points can be set/unset. Hiding
this column does not remove any previously-
set break points.

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

TVO*
Toggle view
outline

Edit: Toggle code folding/outlining for control
structures (including :Section structures) and
functions. When toggled, existing code in an
open Editwindow is automatically updated to
reflect the new rules.

TFR*
Refresh
threads

Debug information window: Forces a refresh
of the Threads area (see Section 5.1.7)

UC Up cursor Up Arrow Move cursor up one character

UL Up limit

Linux: Ctrl +
Home
macOS:⌘
+ Up Arrow
Windows:
Ctrl + Home

Session: Move cursor to top left corner of
Session log
Edit: Move cursor to top left corner of content

US Up screen

Linux: Page
Up
macOS: Fn
+ Up Arrow
Windows:
Page Up

Move cursor up one screen

VAL*
Evaluate
selection or
name

Edit: Evaluate the selected expression or name
and display the result in the Sessionwindow.

WI*
Weak
interrupt

Ctrl +
PauseBreak

Suspend code execution at the start of the next
line (generally after completing execution of the
statement currently being processed)

WSE*
Toggle
Workspace
Explorer

Toggle display of the workspace explorer (see
Section 5.1.6) to the left of the Sessionwindow

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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Code Command
Default

Keystrokes
Description

ZM*
Toggle
maximise
Editwindow

Toggle active Editwindow between current size
and full Session size

ZMI*
Increase font
size

Ctrl + =
or
Ctrl + Shift +
=

Increase the size of the font in all the windows

ZMO*
Decrease font
size

Ctrl + - Decrease the size of the font in all the windows

ZMR*
Reset font
size

Ctrl + 0
Reset the size of the font in all the windows to
its default value

Table A-1: Dyalog keyboard shortcuts supported on the RIDE (continued)
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B Sample Configuration File

A .ini configuration file can be used to define settings for the RIDE_INIT configuration
parameter.

Examples of the fields that you might want to include within the .ini configuration file are:
[RIDE]
Direction=Listen
Address=
Port=5002
MaxBlockSize=52428800
SSLValidation=0
Protocol=IPv4
Secure=Secure
PublicCertFile= C:\apps\d150U64\TCerts\server\localhost-cert.pem
PrivateKeyFile= C:\apps\d150U64\TCerts\server\localhost-key.pem
RootCertDir= C:\apps\d150U64\TCertss\ca
Priority=
AcceptCertDir= C:\apps\d150U64\TCerts\accept

where:
l Direction, Address and Port – as defined for the RIDE_INIT configuration

parameter (see Section 8.2.2). Direction in the .ini file is equivalent to mode in
the RIDE_INIT configuration parameter and has possible values of Listen
(equivalent to RIDE_INIT's Serve), Connect, Poll and HTTP. No defaults are
defined for Direction and Address; the default for Port is 4502. Overridden if
defined in RIDE_INIT.

Setting Direction to HTTP sets the RIDE to Zero Footprint mode (see
Section 4.2). If this is set then an HttpDir field can be included to specify
the full path to (and name of) the directory in which to load the RIDE HTML
files in Zero Footprint mode (the default value assumes that the RIDE is
installed in its default location).

l MaxBlockSize is themaximum size (in bytes) allocated to the buffer that receives
data transmissions. The default is 16,777,216.

l SSLValidation is the sum of the relevant TLS flags (see Section B.1). The default
is 0. Validity depends on the value of the Secure field.
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l Protocol is the communication protocol to use. Possible values are:
o IPv4: use the IPv4 connection protocol; if this is not possible then generate

an error.
o IPv6: use the IPv6 connection protocol; if this is not possible then generate

an error.
o <empty>: use the IPv6 connection protocol; if this is not possible then use

the IPv4 connection protocol. This is the default.
l Secure specifies the security of the connection. Possible values depend on the

value of Direction:
o If Direction is Listen, then Secure can be:

n Secure – the connection is secure and certificates are provided. The
PublicCertFile, PrivateKeyFile, SSLValidation and
Priority fields are valid.

n <empty> – the connection is unencrypted. This is the default.
o If Direction is Connect or Poll, then Secure can be:

n Secure – the connection is secure and certificates are provided. The
PublicCertFile, PrivateKeyFile, SSLValidation and
Priority fields are valid.

n <empty> – the connection is unencrypted. This is the default.
n Anonymous – the connection is secure but no certificate is provided

on the client side. The SSLValidation and Priority fields are
valid.

l PublicCertFile is the fully-qualified path to, and name of, the file containing
the public certificate. Empty by default. Validity depends on the value of the
Secure field.

l PrivateKeyFile is the fully-qualified path to, and name of, the file containing
the private key. Empty by default. Validity depends on the value of the Secure
field.

l RootCertDir is the full path to (and name of) the directory that contains
Certificate Authority root certificates. Empty by default (on theMicrosoft Windows
operating system, the RIDE uses theMicrosoft certicate store).

l Priority is the GnuTLS priority string (for complete documentation of this, see
http://www.gnutls.org/manual/gnutls.html#Priority-Strings). Empty by default.
Validity depends on the value of the Secure field.

l AcceptCertDir is the full path to (and name of) the directory that contains the
public certificates of all users that are allowed to connect. Empty by default.

Two additional sections can be included within the .ini configuration file to control the IP
addresses that are allowed or denied access to the connection. These are:
[AllowEndPoints]
[DenyEndPoints]
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For each of these, IPv6/IPv4 addresses and/or address ranges can be specified (multiple
entries must be separated by commas). For example:
[AllowEndPoints]
IPV4=192.168.100.0/24,192.168.17.0/24,127.0.0.0/10
IPV6= fe80:ccbd:aa34:3cfb::0/64

[DenyEndPoints]
IPV4=212.0.0.0/8
IPV6= 2a02:2658:1012::35/64

If AllowEndPoints is not included, all IP addresses are allowed to access the connection
unless explicitly denied access with the DenyEndPoints field.

B.1 TLS Flags
TLS flags are employed as part of the certificate checking process; they determine whether
a secure client or server can connect with a peer that does not have a valid certificate.
When Direction is Connect or Poll, the RIDE acts as a server; when Direction is
Serve, the RIDE acts as a client.

The code numbers of the TLS flags described in Table B-1 can be added together and
passed to the SSLValidation field to control the certificate checking process. If you do
not require any of these flags, then the SSLValidation field should be set to 0.

Code Name Description

1 CertAcceptIfIssuerUnknown
Accept the peer certificate even if the issuer
(root certificate) cannot be found.

2 CertAcceptIfSignerNotCA
Accept the peer certificate even if it has been
signed by a certificate not in the trusted root
certificates' directory.

4 CertAcceptIfNotActivated
Accept the peer certificate even if it is not yet
valid (according to its valid from information).

8 CertAcceptIfExpired
Accept the peer certificate even if it has
expired (according to its valid to information).

16 CertAcceptIfIncorrectHostName
Accept the peer certificate even if its
hostname does not match the one it was
trying to connect to.

Table B-1: TLS Flags
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Code Name Description

32 CertAcceptWithoutValidating
Accept the peer certificate without checking it
(useful if the certificate is to be checked
manually).

64 RequestClientCertificate

Only valid when the RIDE is acting as a server;
asks the client for a certificate but allows
connections even if the client does not
provide one.

128 RequireClientCertificate

Only valid when the RIDE is acting as a server;
asks the client for a certificate and refuses the
connection if a valid certificate (subject to any
other flags) is not provided by the client.

Table B-1: TLS Flags (continued)

TLS flags have the samemeaning irrespective of whether the RIDE is acting as a server or a
client. However, for a server they are applied each time a new connection is established
whereas for a client they are only applied when the client object is created.
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